Teamcenter 10.1

Workflow Viewer Guide
Proprietary and restricted rights notice

This software and related documentation are proprietary to Siemens Product Lifecycle Management Software Inc.

© 2013 Siemens Product Lifecycle Management Software Inc. All Rights Reserved.

Siemens and the Siemens logo are registered trademarks of Siemens AG. Teamcenter is a trademark or registered trademark of Siemens Product Lifecycle Management Software Inc. or its subsidiaries in the United States and in other countries. All other trademarks, registered trademarks, or service marks belong to their respective holders.
Contents

Proprietary and restricted rights notice ........................................... 2

Getting started with Workflow Viewer ........................................... 1-1

Before you begin .................................................................................. 1-1
What is a workflow? ............................................................................ 1-1
What is Workflow Viewer? ................................................................. 1-2
Performing tasks ................................................................................. 1-3
What can you do in Workflow Viewer? ............................................. 1-4
Task states ......................................................................................... 1-5
Workflow Viewer interface ................................................................... 1-5

Viewing workflows ............................................................................ 2-1

Open a process ................................................................................... 2-1
Determining who are assigned to a workflow ................................... 2-5
Determining the workflow’s status .................................................... 2-7
Checking a task’s properties ............................................................... 2-11
View audit information ....................................................................... 2-17
Viewing workflow and schedule progress .......................................... 2-23

Using ad hoc process modification .................................................... 3-1

Modifying active workflow processes .............................................. 3-1
Ad hoc modification ........................................................................... 3-1
Edit an active workflow process ....................................................... 3-2
What are workflow subprocesses? ................................................ 3-4
Create a workflow subprocess ........................................................ 3-4
Stopping a workflow process in Workflow Viewer ........................... 3-6

Tasks you can perform ....................................................................... 4-1

Performing tasks in Workflow Viewer .............................................. 4-1
Selecting a signoff team ..................................................................... 4-2
Signing off an Acknowledge or Review task ..................................... 4-7
Perform a Do task in Workflow Viewer ............................................. 4-12
Perform a Condition task manually in Workflow Viewer .................. 4-13
Perform a Route task in Workflow Viewer ....................................... 4-15
Perform a Custom task in Workflow Viewer ..................................... 4-16
Reassign a task in Workflow Viewer ................................................ 4-16
Claim a task ...................................................................................... 4-17

Changing a task’s state ...................................................................... 5-1

Overriding task actions ..................................................................... 5-1
Perform action ................................................................................... 5-2
Complete a task with attached form ................................................. 5-3
Starting a paused task ....................................................................... 5-3
Contents

Reset a paused task ......................................................... 5-3
Suspend a task ..................................................................... 5-4
Resume a task ...................................................................... 5-4
Skip a task in a process and start the next one ....................... 5-5
Demote a task ...................................................................... 5-5

Workflow templates in Teamcenter Rapid Start ...................... 6-1
Workflow templates in Teamcenter Rapid Start ...................... 6-1
Engineering Order .............................................................. 6-1
Production Release .............................................................. 6-2
Obsolescence Process .......................................................... 6-3
Development Release ........................................................... 6-3
Status Change ...................................................................... 6-4
Change Status to Rejected .................................................... 6-4
Change Status to Review ....................................................... 6-5
Change Status to Released ................................................... 6-6

Glossary .............................................................................. A-1

Index .................................................................................. Index-1

Figures

Task actions and states ............................................................ 5-2
Chapter

1  Getting started with Workflow Viewer

Before you begin ................................................................. 1-1
What is a workflow? .............................................................. 1-1
What is Workflow Viewer? ..................................................... 1-2
Performing tasks ................................................................. 1-3
What can you do in Workflow Viewer? .................................... 1-4
Task states ................................................................. 1-5
Workflow Viewer interface ........................................... 1-5
  Workflow Viewer view ......................................................... 1-5
  Workflow Viewer menus ....................................................... 1-7
    File menu ................................................................. 1-7
    Edit menu ................................................................. 1-7
    View menu ................................................................. 1-8
    Actions menu ............................................................... 1-9
    Go menu ................................................................. 1-10
Workflow Viewer buttons .............................................. 1-10
Workflow Viewer panes .............................................. 1-12
  Task Attributes pane ................................................... 1-12
  Task Attachments pane .................................................. 1-13
  Task Handlers pane ....................................................... 1-14
  Signoff profiles pane .................................................... 1-14
  Teamcenter rich client perspectives and views ..................... 1-14
Chapter

1  Getting started with Workflow Viewer

Before you begin

<table>
<thead>
<tr>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>You do not need any special permissions to use the Workflow Viewer application. However, privileges granted with the \texttt{WORKFLOW_adhoc_process} preference are required to edit active workflow processes.</td>
</tr>
</tbody>
</table>

For more information about this preference, see the \textit{Preferences and Environment Variables Reference}.

<table>
<thead>
<tr>
<th>Enable Workflow Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Viewer does not need to be enabled before you use it.</td>
</tr>
</tbody>
</table>

If you have trouble accessing Workflow Viewer, see your system administrator; it may be a licensing issue.

<table>
<thead>
<tr>
<th>Configure Workflow Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Viewer does not need to be configured.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Start Workflow Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click Workflow Viewer 📚 in the navigation pane.</td>
</tr>
</tbody>
</table>

What is a workflow?

A \textit{workflow} is the automation of business procedures in which documents, information, or tasks are passed from one participant to another in a way that is governed by rules or procedures. Teamcenter workflows allow you to manage your product data processes. You can create any type of workflow to accommodate your business procedures.
A pharmaceutical company decides to implement workflows to shorten drug development time, speeding medicines to people in need and strengthening business performance.

After researching workflow solutions and investigating their own company processes, the company determines the need for imaging software to manage the drug test case report forms, data query software to reduce correction time when errors were found in clinical data, and data management software to enforce data integrity. Life cycle data management software such as Teamcenter provides all these solutions in a single product.

A production workflow is created and run in Teamcenter. The workflow is initiated against each product revision (each version of each drug testing). The workflow sends the required forms to the appropriate users, verifies product requirements, routes approvals and notifications to stakeholders, sends cost spreadsheets to the financial department at specific intervals, and rigorously manages the company’s change management processes.

The benefits of automating your business processes include:

- Improved efficiency. The automation of your business processes can result in the elimination of unnecessary steps.
- Better process control. Company business processes are more easily managed with standardized work methods and the availability of audit trails.
- Improved customer service. Consistent business processes increases predictability in levels of response to customers.
- Flexibility. Computer-modeled processes can be quickly and easily redesigned to meet changing business needs.
- Continual process improvement. The resulting focus on business processes leads to their streamlining and simplification.

**What is Workflow Viewer?**

Workflow Viewer is an application that provides more functionality than is available in My Teamcenter for workflows. In Workflow Viewer, you can:

- View any initiated workflow process, whether it is currently in process or has already completed.
- Edit an active workflow process, if you have write permissions.

You can view workflow processes from your worklist by selecting a task and selecting **Process View** in the **Viewer** view. However, this method limits you to viewing only those workflow processes that contain tasks assigned to you at the time the task remains in your worklist.

However, Workflow Viewer allows you to view the progress of a workflow process, even if you are not a participating member of that particular workflow process. If you have read privileges for the workflow process data, you can view any workflow
process in the database, whether it is currently in process or has already achieved its final status.

**Note**  
**My Worklist** in My Teamcenter is designed to provide a more streamlined process for progressing through workflow processes to which you are associated. The worklist lists only those tasks that you can perform or that you are assigned to track.

For more information about using your worklist, see the *My Teamcenter Guide*.

**Example**  
The following workflow process shows that the **Change Admin I** task is complete, that the **Author Technical Recommendation** task has started, and that the remaining tasks are pending. The name of the **Check Change Type** task (a **Condition** task) indicates whether the workflow branches to either an author or change review board (CRB) business decision, depending on what type of change object is the target of the workflow.

**Performing tasks**

You can perform workflow tasks assigned to you from two different locations within Teamcenter:

- **My Worklist** in the **My Teamcenter** view

- Workflow Viewer

Using **My Worklist** is the streamlined method for performing workflow tasks. It is the method you typically use to perform tasks assigned to you.
Occasionally, tasks must be delegated to different users or bypassed. For example, a team lead might need to delegate a signoff task for team member who is on extended leave. Or an system administrator must promote a task left unfinished by an employee no longer with the company.

A privileged user can promote, demote, or delegate workflow tasks assigned to other users. These actions must be performed in Workflow Viewer.

Types of privileged users are:

**Responsible party**  
Generally, the responsible party is the person assigned to perform the task. In which case the responsible party can perform any assigned task from his worklist as easily as from Workflow Viewer.

This is not true for the **perform-signoffs** task, in which multiple users are responsible for performing signoffs. Though each member of the signoff team is responsible for performing a signoff, the responsible party is the process initiator not the individual members of the signoff team. The responsible party has the privilege to delegate signoff responsibility to another user. Delegation of signoff responsibility typically occurs when a signoff team member is unexpectedly unable to perform the signoff. If the responsible party wants to delegate another users’ signoff responsibility to a different user, he must use Workflow Viewer.

**Process initiator**  
The user who initiates the workflow process against a Teamcenter object (by selecting an object and choosing **File→New→Workflow Process**) is the process initiator.

When a workflow process is initiated, the process owner becomes the responsible party for the workflow process. The process initiator is the responsible party for any task not explicitly assigned to another user, person, or resource pool.

### What can you do in Workflow Viewer?

Workflow Viewer presents a dynamic user interface for viewing an entire workflow process, even if you are not a participating member. This perspective on a workflow process is wider than provided from your **My Worklist** view and is best suited for advanced workflow users.

In addition to viewing the entire scope of a workflow process, you can use Workflow Viewer to:

- **Modify active workflow processes.**
- **Perform workflow tasks.**
- **Override task actions.**
You can also perform workflow tasks and override task actions from your worklist. The worklist view is streamlined to display only tasks assigned to you that are currently active and waiting for completion.

You can also view the entire workflow process from your worklist, though the view provides less window space than Workflow Viewer.

**Task states**

Task states are displayed in the upper left-hand corner of each task.

<table>
<thead>
<tr>
<th>Task state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>The task has not yet started. A task cannot start until the previous release level has completed.</td>
</tr>
<tr>
<td>Started</td>
<td>The task is now active and action can be taken upon the task.</td>
</tr>
<tr>
<td>Completed</td>
<td>The required actions have been performed. A <strong>Completed</strong> state for a <strong>Review</strong> task means that all signoffs have been performed and the number of approvals are equal to that specified in the quorum for the task.</td>
</tr>
<tr>
<td>Skipped</td>
<td>The task has been skipped by a privileged user. If this is a <strong>Review</strong> task, all signoff subtasks show the <strong>No Decision</strong> image, indicating the release task was skipped, rather than completed.</td>
</tr>
<tr>
<td>Suspended</td>
<td>The task has been suspended. If this is a <strong>Review</strong> task, all signoff tasks are removed from the Worklist.</td>
</tr>
<tr>
<td>Failed</td>
<td>A task’s state is set to <strong>Failed</strong> if the task is configured with a failure path and if the failure conditions are met.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The <strong>Failed</strong> state does not appear on the <strong>Actions</strong> menu, because it can only be triggered internally.</td>
</tr>
<tr>
<td>Unassigned</td>
<td>The signoff team for a <strong>Review</strong> task is not yet assigned.</td>
</tr>
<tr>
<td>Aborted</td>
<td>The task is canceled and the workflow process is exited without being completed.</td>
</tr>
</tbody>
</table>

**Workflow Viewer interface**

**Workflow Viewer view**

Workflow Viewer uses the standard Teamcenter rich client interface. There are some panes, buttons, menus, and menu commands that are specific to Workflow Viewer.
Chapter 1  Getting started with Workflow Viewer

1 Task hierarchy tree  Displays the root-level workflow process, along with its tasks and subtasks, in a hierarchical listing. Task precedence in the task hierarchy tree is based on the order in which the tasks were created.

2 Template manager pane  Displays the name and description of the selected task.

3 Process flow pane  Displays graphical views of the different levels of a workflow process. You can view all the tasks in an entire workflow process, or the subtasks in a task, or the subtasks of subtasks, and so forth.

There are two ways you can view tasks and subtasks in Workflow Viewer:

- Select a task in the task hierarchy tree.
  The process flow pane displays the selected task's subtasks in a graphical display.

- Double-click the desired task in the process flow pane.
  The process flow pane advances down a level and displays the selected task's subtasks.
Workflow Viewer menus

File menu

The File menu contains the Close and Exit commands. Choose Close to shut down the Workflow Viewer or Exit to leave the rich client.

Edit menu

The Edit menu contains commands used for editing workflow process properties.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template</td>
<td>Lists the task templates available in Teamcenter.</td>
</tr>
<tr>
<td>Template→Task</td>
<td>Workflow Designer default template setting. The Task template is synonymous with the EPMTask template.</td>
</tr>
<tr>
<td>Template→Do Task</td>
<td>Has two options if at least one failure path is configured: Complete confirms the completion of a task and triggers the branching to a success path. Unable to Complete indicates the task is unable to complete, for various reasons. Uses the EPM-hold handler, which stops the task from automatically completing when started.</td>
</tr>
<tr>
<td>Template→Review Task</td>
<td>Uses the select-signoff-team and perform-signoff subtasks, each of which has their own dialog box.</td>
</tr>
<tr>
<td></td>
<td>Wait for Undecided Reviewers is an option to set the Review task to wait for all reviewers to submit their decisions before completing and following the appropriate path.</td>
</tr>
<tr>
<td>Template→Add Status Task</td>
<td>Creates and adds a release status to the target objects of the workflow process. It is a visual milestone in a workflow process. There is no dialog box associated with this type of task.</td>
</tr>
<tr>
<td>Template→Or Task</td>
<td>Inserts an Or task into the workflow process. This task continues the workflow process when any one of its multiple task predecessors is completed or promoted. There is no limit to the number of predecessors an Or task may have.</td>
</tr>
<tr>
<td>Template→Acknowledge Task</td>
<td>Inserts an Acknowledge task into the workflow process. This task uses the Acknowledged and Not Acknowledged subtasks, each of which has its own dialog box.</td>
</tr>
</tbody>
</table>
### Command ➔ Description

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template→Condition Task 🌟</td>
<td>Inserts a <strong>Condition</strong> task into the workflow process. This task requires that the succeeding task contains a <strong>EPM-check-condition</strong> handler that accepts <strong>True</strong>, <strong>False</strong>, or any string corresponding to custom result string configured on the paths emerging from the preceding <strong>Condition</strong> task.</td>
</tr>
<tr>
<td>Template→Route Task 🌻</td>
<td>Inserts a <strong>Route</strong> task into the workflow process. This task uses the <strong>Review</strong>, <strong>Acknowledge</strong>, and <strong>Notify</strong> subtasks, each of which has its own dialog box.</td>
</tr>
<tr>
<td>Template→Validate Task 🌿</td>
<td>Inserts a <strong>Validate</strong> task into the workflow process. This task gives you the ability to respond to errors by providing an alternate path which the workflow process traverses when an error occurs.</td>
</tr>
<tr>
<td>Copy Workflow Process</td>
<td>Copies the workflow process to the clipboard</td>
</tr>
<tr>
<td>Mode→Execute</td>
<td>Initiates <strong>Execute</strong> mode to perform workflow process tasks.</td>
</tr>
<tr>
<td>Mode→Design</td>
<td>Initiates <strong>Design</strong> mode to perform ad hoc process modification.</td>
</tr>
</tbody>
</table>

### View menu

The **View** menu contains commands used for viewing workflow process properties.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Properties</td>
<td>Opens a <strong>Task Properties</strong> dialog box that presents task information in a concise format. Unlike <strong>Properties</strong>, <strong>Task Properties</strong> displays only relevant information to the selected task.</td>
</tr>
<tr>
<td>Access</td>
<td>Contains the user, group and role assigned to this task, if any. You can open the <strong>ACL Control List</strong> and <strong>Extra-Protection</strong> dialog boxes for reference. Access control lists can be viewed and edited in Workflow Viewer. Create an access control list from the Access Manager. For more information, see the <strong>Access Manager Guide</strong>.</td>
</tr>
</tbody>
</table>
### Command Description

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Audit→View Audit Logs</strong></td>
<td>This command appears only if the <strong>TC_audit_manager</strong> preference is set to <strong>ON</strong> and the <strong>TC_audit_manager_version</strong> preference is set to <strong>2</strong>.</td>
</tr>
<tr>
<td></td>
<td>Opens the <strong>Audit Log</strong> dialog box. Enter query data into the text boxes to perform a search on any objects in the database. The search returns a history of the actions taken on the defined objects.</td>
</tr>
<tr>
<td></td>
<td>For more information about viewing audit logs, see <strong>View legacy audit log information</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Audit logs are based on site-defined audit definition objects. Default settings of the Audit Manager provide audit definitions for workflow and checkin/checkout events, allowing audit logs to be automatically created for these functions. Site-defined audit definitions must be created to generate general workflow and checkin/checkout audit logs.</td>
</tr>
<tr>
<td></td>
<td>For more information about creating audit definition objects or about legacy audit functionality, see the <strong>Audit Manager Guide</strong>.</td>
</tr>
<tr>
<td><strong>Organization</strong></td>
<td>Displays a read-only organization chart.</td>
</tr>
<tr>
<td></td>
<td>For more information, see the <strong>Organization Guide</strong>.</td>
</tr>
</tbody>
</table>

#### Actions menu

The **Actions** menu contains commands used for setting the actions of tasks. All commands on the **Actions** menu require **privileged user** status to function.

If a task is designated to process in the background, all actions except **Perform** and **Assign** are processed in the background. The **Perform** and **Assign** action execute in the foreground.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Perform</strong></td>
<td>Displays the <strong>Perform</strong> dialog box for the selected task. The contents of the dialog box varies depending on the task selected.</td>
</tr>
<tr>
<td><strong>Assign</strong></td>
<td>Reassigns the selected task to another user.</td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>Manually starts a task. This command works only in certain circumstances.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <strong>Starting a paused task</strong>.</td>
</tr>
<tr>
<td><strong>Complete</strong></td>
<td>Manually completes a task, if it is in either the <strong>Started</strong> or <strong>Pending</strong> states.</td>
</tr>
<tr>
<td><strong>Suspend</strong></td>
<td>Moves a selected task to a <strong>Suspended</strong> state. The only valid action from a <strong>Suspended</strong> state is <strong>Resume</strong>.</td>
</tr>
</tbody>
</table>
Chapter 1  Getting started with Workflow Viewer

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resume</td>
<td>Moves a selected task from a <strong>Suspended</strong> state to the previous state.</td>
</tr>
<tr>
<td>Promote</td>
<td>Places the selected task into a <strong>Skipped</strong> state, and starts the successor tasks in the workflow process. For <strong>Review</strong> and <strong>Route</strong> tasks, the successor task can be either along the approve or reject path, depending on the user’s selection.</td>
</tr>
<tr>
<td>Demote</td>
<td>Demotes a task is to retract workflow process control. The selected task changes from a <strong>Started</strong> state to a <strong>Pending</strong> state. To demote subtasks and restart the predecessor tasks, an <strong>EPM-demote</strong> handler must be built into the selected tasks template.</td>
</tr>
<tr>
<td>Stand-In</td>
<td>Allows you to perform the task while allowing the original user to retain control.</td>
</tr>
<tr>
<td>Abort</td>
<td>Cancels a workflow process and exits without workflow process completion.</td>
</tr>
<tr>
<td>Claim Task</td>
<td>Allows you to reassign a task to yourself.</td>
</tr>
</tbody>
</table>

**Go menu**

The **Go** menu contains commands used for maneuvering through a workflow process.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up a level</td>
<td>In the task hierarchy tree, opens the parent task of the currently selected task. The remaining views are initialized accordingly.</td>
</tr>
<tr>
<td>Down a level</td>
<td>The currently selected task in the process flow pane is selected in the task hierarchy tree and the remaining task views are initialized accordingly.</td>
</tr>
<tr>
<td></td>
<td>If there is no task selected in the process flow pane, the first subtask of the currently selected task in the task hierarchy tree is selected and the other task views are initialized accordingly.</td>
</tr>
<tr>
<td>Top level</td>
<td>In the task hierarchy tree, opens the root task of the workflow process.</td>
</tr>
</tbody>
</table>

**Workflow Viewer buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Properties 📝</td>
<td>Displays the name, description, attributes, and handlers of the selected task.</td>
</tr>
<tr>
<td>Open By Name 🌊</td>
<td>Searches for a workflow process by name.</td>
</tr>
<tr>
<td>MRU 🔄</td>
<td>Displays the mostly recently opened workflow processes.</td>
</tr>
</tbody>
</table>
### Getting started with Workflow Viewer

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Attributes 📝</td>
<td>Displays and opens for edit the named ACL, task type, and quorum requirements for the selected task. For more information, see Task Attributes pane.</td>
</tr>
<tr>
<td>Task Attachments 📁</td>
<td>Displays and opens for edit the attachments to the selected task.</td>
</tr>
<tr>
<td>Task Handlers 📜</td>
<td>Displays and opens for edit task task handlers for the selected task. For more information, see Task Handlers pane</td>
</tr>
<tr>
<td>Task Signoffs 🌐</td>
<td>Displays and opens for edit the group, role, quorum, and number of reviewer requirements for the selected task. For more information, see Signoff profiles pane.</td>
</tr>
<tr>
<td>Task 📕</td>
<td>Inserts an empty task with no handlers into the workflow template for you to customize.</td>
</tr>
<tr>
<td>Perform Task 🌟</td>
<td>Starts the required work for the task. For example, to complete a select-signoff-team task, the responsible party clicks the Perform Task button and then selects team members meeting the defined group and role requirements to complete the task.</td>
</tr>
<tr>
<td>Do Task 🌟</td>
<td>Inserts a Do task into the workflow template. This task has two options, if at least one failure path is configured: Complete confirms the completion of a task and triggers the branching to a success path. Unable to Complete indicates the task is unable to complete, for various reasons.</td>
</tr>
<tr>
<td>Review Task 🎨</td>
<td>Inserts a Review task into the workflow template. This task uses the select-signoff-team and perform-signoffs subtasks, each of which has its own dialog box. <strong>Wait for Undecided Reviewers</strong> is an option that allows the workflow designer user to set the Review task to wait for all reviewers to submit their decisions before completing and following the appropriate path.</td>
</tr>
<tr>
<td>Add Status Task 🧪</td>
<td>Inserts an Add Status task into the workflow template. This task creates and adds a release status to the target objects of the workflow process. It is a visual milestone in a workflow process. There is no dialog box associated with this type of task.</td>
</tr>
<tr>
<td>Or Task</td>
<td>Inserts an Or task into the workflow process. This task continues the workflow process when any one of its multiple task predecessors is completed or promoted. There is no limit to the number of predecessors an Or task may have.</td>
</tr>
</tbody>
</table>
**Button** | **Description**
--- | ---
**Acknowledge Task** | Inserts an **Acknowledge** task into the workflow template. This task uses the **Acknowledged** and **Not Acknowledged** subtasks, each of which has its own dialog box.

**Condition Task** | Inserts a **Condition** task into the workflow template. This task requires that the succeeding task contains an **EPM-check-condition** handler that accepts a Boolean value of either **True** or **False**.

**Route Task** | Inserts a **Route** task into the workflow template. This task uses the **Review, Acknowledge**, and **Notify** subtasks, each of which has its own dialog box.

**Validate Task** | Inserts a **Validate** task into the workflow template. This task gives you the ability to respond to errors by providing an alternate path which the workflow process traverses when an error occurs.

**Up a Task Level** | Displays the task one level higher than the current task.

**Down a Task Level** | Displays the task one level lower than the current task.

---

**Workflow Viewer panes**

**Task Attributes pane**

Click the **Task Attributes** button to display the **Task Attributes** pane.

**Element** | **Description**
--- | ---
**State** | Displays the task’s state, such as **Started**, **Pending**, or **Completed**.

For more information, see **Task states**.

**Responsible Party** | Displays the responsible party for the task.

For more information, see **Types of Workflow users**.

**Named ACL** | Click to display the **Named ACL** dialog box.

For more information about configuring access control lists (ACLs), see the **Access Manager Guide**.

**Condition Query** | Displays when a **Condition** task is selected. The entry lists the query selected to determine the true and false paths of the **Condition** path. If a query has not yet been defined, it is listed as empty.

Click the entry to display the **Condition Query** dialog box, which you can use to change, modify, or delete the defined query.
### Element | Description
--- | ---
Condition Result | Displays when a **Condition** task is selected. The entry lists the required result of the query: either **true** or **false**.

Due Date | Displays when the selected task contains a due date. The entry lists the date by which the task must be completed. If the task is not completed by the specified date, the task's status changes to late, and the task becomes overdue.

Click **Due Date** to display the **Due Date** dialog box, which you can use to set the date and time by which the task must be completed. If the task is not completed by the specified date, the task's status changes to late, and the task becomes overdue.

Duration | Displays when the selected task contains a defined duration. The entry lists the length of time allowed for the completion of the project. If the task is not completed within the specified amount of time, the task's status changes to late, and the task becomes overdue.

Click **Set** to display the **Set Duration** dialog box, which you can use to set a length of time in which the task must be performed. If the task is not completed within the specified amount of time the task's status changes to late, and the task becomes overdue.

Recipients | Displays the names of users selected to receive program mail when the selected task becomes overdue.

Click **Set** to display the **Select Recipients** dialog box, which you can use to select users who will receive program mail if the selected task becomes overdue.

Show Task in Process Stage List | Displays if the **Set Stage to Available** check box is available.

Process in Background | Indicates if the task is to be executed in the background.

**Task Attachments pane**

Click the **Task Attachments** button to display the **Task Attachments** pane.

The pane displays the objects attached to the workflow as targets or references. You can open, cut, copy, or paste the objects with the respective buttons in the pane.
Task Handlers pane

Click the Task Handler button to display the Handlers pane. The Handlers pane cannot be edited.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Handler tree</td>
<td>Lists folders representing each of the task actions. Each folder contains the handlers associated with that task action. Action handlers exist as direct descendants of the parent task action folders. Rule handlers exist as children of rules. Rules are direct descendants of task action folders.</td>
</tr>
<tr>
<td>Handler Type</td>
<td>Specifies the handler types: action handler or rule handler.</td>
</tr>
<tr>
<td>Quorum</td>
<td>Indicates how many rule handlers must be satisfied before the rule is satisfied, therefore allowing the workflow process to proceed. When a rule handler is selected, an integer appears representing the number required.</td>
</tr>
<tr>
<td>Rule/Action Handler</td>
<td>Selects the handler by name.</td>
</tr>
<tr>
<td>Argument/Value(s)</td>
<td>When a predefined handler is selected, displays the predefined arguments and values for the handler.</td>
</tr>
<tr>
<td>Help</td>
<td>Selecting a handler from the Task Handler tree and clicking Help displays the documentation for the selected handler.</td>
</tr>
</tbody>
</table>

Signoff profiles pane

Click the Task signoff profiles button to display the Signoff profiles pane.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signoff Profiles</td>
<td>Displays the name of the selected workflow process.</td>
</tr>
<tr>
<td>tree</td>
<td></td>
</tr>
<tr>
<td>Signoffs Quorum</td>
<td>Lists the number or percent of signoffs required for the task to complete, and displays the Wait for Undecided Reviewers option that allows the Review task to wait for all reviewers to submit their decisions before completing and following the appropriate path.</td>
</tr>
</tbody>
</table>

Teamcenter rich client perspectives and views

Within the Teamcenter rich client user interface, functionality is provided in perspectives and views. Some applications use perspectives and views to rearrange how the functionality is presented. Other applications use a single perspective and view to present information.

- Perspectives

  Are containers for a set of views and editors that exist within the perspective.

  - A perspective exists in a window along with any number of other perspectives, but only one perspective can be displayed at a time.
In applications that use multiple views, you can add and rearrange views to display multiple sets of information simultaneously within a perspective.

You can save a rearranged perspective with the current name, or create a new perspective by saving the new arrangement of views with a new name.

- Views and view networks

In some Teamcenter applications, using rich client views and view networks, you can navigate to a hierarchy of information, display information about selected objects, open an editor, or display properties.

Views that work with related information typically react to selection changes in other views.

Changes to data made in a view can be saved immediately.

Any view can be opened in any perspective, and any combination of views can be saved in a current perspective or in a new perspective.

A view network consists of a primary view and one or more secondary views that are associated. View networks can be arranged in a single view folder or in multiple view folders.

Objects selected in a view may provide context for a shortcut menu. The shortcut menu is usually displayed by right-clicking.

For more information about using the shortcut menu, see the My Teamcenter Guide.

**Note** If your site has online help installed, you can access application and view help from the rich client Help menu or by pressing F1. Some views, such as Communication Monitor, Print Object, and Performance Monitor, are auxiliary views that may be used for debugging and that may not be displayed automatically by any particular perspective.

For more information about auxiliary views, see the Client Customization Programmer's Guide.

For more information about perspectives and views and changing the layout of your rich client window, see the Rich Client Interface Guide.
Chapter

2 Viewing workflows

Open a process .................................................. 2-1
Open a parent process ........................................ 2-1
Open a subprocess ............................................. 2-1
Open a workflow process from an object .................. 2-1
Open a workflow process from a reference ............... 2-2
Opening processes ............................................ 2-3
  Opening a parent workflow process in Workflow Viewer 2-3
  Opening a workflow subprocess in Workflow Viewer .... 2-3
  Opening a workflow process from an object ............. 2-4
  Opening a workflow process from a reference .......... 2-4
Workflow Viewer and your processes ....................... 2-5

Determining who are assigned to a workflow .......... ... 2-5
  Determining a task’s responsible party ................. 2-5
View signoff team profiles .................................. 2-6
Types of Workflow users ................................... 2-6

Determining the workflow’s status ....................... 2-7
  Determining task status .................................. 2-7
Viewing task flow ............................................ 2-9

Checking a task’s properties ............................... 2-11
  Determining task type ................................... 2-11
View task attributes ........................................ 2-13
Set due date in Workflow Viewer ............................ 2-14
Set duration in Workflow Viewer ............................ 2-15
Set recipients list in Workflow Viewer .................... 2-15
View task attachments ..................................... 2-16
View task handlers .......................................... 2-16

View audit information ...................................... 2-17
  Viewing audit information ............................... 2-17
View audit logs in the Summary view ....................... 2-18
Process reports ............................................. 2-19
Creating and running audit queries ........................ 2-20
Export audit logs to Microsoft Excel ....................... 2-20
View legacy audit log information ......................... 2-21

Viewing workflow and schedule progress .................. 2-23
  Reviewing workflow and schedule progress by viewing the process history ................................... 2-23
Customize the process history display ..................... 2-24
Process reports ............................................. 2-25
Print the process history report .................................................. 2-26
Export audit logs or process history to Microsoft Excel .................. 2-26
Chapter 2 Viewing workflows

Open a process

Open a parent process

• To see a list of parent process nodes for a workflow subprocess, click the parent workflow process button.

• To open a parent process, double-click the parent workflow process button. The workflow subprocess closes and the parent workflow process appears in the process flow pane.

• In the parent workflow process, the workflow subprocess button appears at the location the workflow subprocess occurs.

Open a subprocess

• From a parent workflow process displaying the subprocess button, open a subprocess using one of the following methods:
  o Click the subprocess button to display the list of associated subprocesses. Click a subprocess in the list.
  o Double-click the subprocess button. The first subprocess in the list opens.

The parent process closes and the selected subprocess appears in the process flow pane.

In the subprocess, the parent workflow process button appears at the locations the parent process encompasses the workflow subprocess.

Open a workflow process from an object

1. Select a Teamcenter object that is, or has been, involved in a workflow process using one of the following methods:
   • Select an object from your worklist.
Chapter 2  Viewing workflows

- Search for in-process objects using the **WF-Object in Process** defined search. For more information about using search, see the *Rich Client Interface Guide*.

- Select an object from any assembly.

  **Note**  In-process objects are indicated by the ♦ symbol. Objects already granted release status are indicated by the ♦ symbol.

2. Right-click the selected object and choose **Send To → Workflow Viewer**. The Workflow Viewer view is opened, and the workflow process displays in the process flow pane.

By default, the workflow process displays in **Execute** mode. This mode allows you to view all workflow process details. If the workflow process contains any tasks assigned to you, you can perform them in **Execute** mode.

The **Design** mode is used by privileged users to modify active workflow processes.

**Open a workflow process from a reference**

1. Select a Teamcenter object that is, or has been, involved in a workflow process using one of the following methods:
   - Select an object from your worklist.
   - Search for in-process objects using the **WF-Object in Process** defined search. For more information about using search, see the *Rich Client Interface Guide*.
   - Select an object from any assembly.

  **Note**  In-process objects are indicated by the ♦ symbol. Objects already granted release status are indicated by the ♦ symbol.

2. Click the **Impact Analysis** tab.

3. Set the **Where** box to **Referenced** and the **Depth** box to **All Levels**. All references to the selected object display in the bottom pane, including all workflow processes.

4. Open any workflow process by right-clicking the workflow object from the **Where Referenced** results and choosing **Send To → Workflow Viewer**. The Workflow Viewer view is opened, and the workflow process appears in the process flow pane.

By default, the workflow process displays in **Execute** mode. This mode allows you to view all workflow process details. If the workflow process contains any tasks assigned to you, you can perform them in **Execute** mode.

The **Design** mode is used by privileged users to modify active workflow processes.
Opening processes

Opening a parent workflow process in Workflow Viewer

Workflow processes can be associated with child workflow processes. Users can create subprocesses while performing tasks from their worklist or Workflow Viewer. When subprocesses are created in this manner, the parent workflow processes are dependent upon subprocesses; they cannot complete until the subprocess completes.

The existence of a parent workflow process is indicated within a subprocess by a white circle outlined in yellow. For example, the following workflow process indicates that the entire workflow is a child workflow process related to a parent workflow process.

Open a parent workflow process by double-clicking the parent process button.

For the specific steps required to open a parent workflow process, see Open a parent process.

Opening a workflow subprocess in Workflow Viewer

Subprocesses are child workflow processes of a parent workflow process. Users can create ad hoc subprocesses while performing tasks from their worklist or Workflow Viewer. When created in this manner, parent workflow processes are dependent upon subprocesses; they cannot complete until the subprocess completes.

You can create both dependent and nondependent subprocesses from the worklist. A nondependent subprocess does not have tasks that depend on the subprocess's completion.

A typical scenario is one in which a user receives a task in his worklist that is dependent upon the completion of an additional workflow process. The user creates a workflow subprocess to track the work which must be completed before he can complete the task in the parent workflow.

For information about creating subprocesses, see What are workflow subprocesses?

The existence of a subprocess within a parent process is indicated by a yellow circle outlined in white. For example, the following workflow indicates that the select-signoff-team task within a parent process is associated with a subprocess.
Display the list of associated subprocesses by clicking the subprocess button. Click a name in the list to open the subprocess in Workflow Viewer. (Double-clicking the subprocess button opens the first subprocess in the list.)

For the specific steps required to open a subprocess, see *Open a subprocess.*

**Opening a workflow process from an object**

You can open workflow processes in Workflow Viewer by selecting any object associated with a workflow process and choosing the **Send To** command from the shortcut menu to send the object to Workflow Viewer. You can select an object from anywhere within the rich client. The act of sending the object to Workflow Viewer opens the workflow process, allowing you to view all aspects of the workflow process. This method is useful for viewing the most current workflow associated with the selected object.

For example, perhaps you worked on a subassembly last week. A review process has since been initiated for the subassembly. You are not on the review team but want to read the review comments. Having recently worked on the subassembly, the object is still in your **Home** folder. You can right-click the subassembly and choose the **Send To** command to send the subassembly to Workflow Viewer. Then choose the **Actions→Perform** command to open the **Perform Signoff** dialog box. Because you are not a member of the review team, you cannot perform the signoff. But you can click the **Browse Signoffs** tab to read all reviewer comments.

In another example, perhaps you want to view all active workflow processes. You can use Teamcenter’s search feature to identify all objects of a specified type currently in a workflow process, and then send each object Workflow Viewer to view them in detail. In the **Search** view, select **WF – Object in Process** from the **System Defined Searches** folder. Then select which type of object you want to find in active workflow processes, such as item revisions or master parts. Run the search, and then select objects one by one from the **Search Results** tab, using the **Send To** command to send the objects to Workflow Viewer, which opens the associated workflow.

For more information about using search, see the *Rich Client Interface Guide.*

**Opening a workflow process from a reference**

You can open workflow processes in Workflow Viewer by performing a **Where Referenced** search on any object ever associated with a workflow process, and then using the **Send To** command to send any of the referenced workflow processes to Workflow Viewer. This method is useful for viewing older workflows and workflow subprocesses associated with an object.

For example, perhaps you worked on a subassembly last year. Several workflow processes have since been initiated against the subassembly. You want to see all
the workflow processes associated with the subassembly. You can use the Search command to find the subassembly, and then click the Impact Analysis tab and perform a Where Referenced search on the subassembly. Setting the depth of the reference search to cover all levels ensures that all workflow processes associated with the subassembly appear. You can then open any workflow process from the Where Referenced search results by selecting the desired workflow process and using the Send To command to send the subassembly to Workflow Viewer.

For more information about using the Where Referenced search, see the Rich Client Interface Guide.

### Workflow Viewer and your processes

<table>
<thead>
<tr>
<th>Term/Concept</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process</td>
<td>A process is the automation of a business procedure, describing the individual tasks and task sequences required to complete a business procedure.</td>
</tr>
<tr>
<td>Process template</td>
<td>Workflow processes are created based on a process template, which functions as a blueprint of the workflow process. A specific workflow process is defined by placing workflow and/or change management tasks in the order they should be performed. Process templates are created using Workflow Designer.</td>
</tr>
<tr>
<td>Tasks</td>
<td>The fundamental building block used to construct a process is a task. Each task defines a set of actions, rules, and resources used to accomplish that task. User actions cause tasks to move from one state to another, and as a result, the overall process moves forward or backward.</td>
</tr>
</tbody>
</table>

### Determining who are assigned to a workflow

#### Determining a task’s responsible party

Each task within a workflow process has a responsible party. The responsible party is the person responsible for performing the task.

When viewing workflow processes in Workflow Viewer, you can determine the responsible party by placing the cursor over the Responsible Party button in the upper-right corner of each task.

![Responsible Party: Smith, Joe](image)
In the case of perform-signoffs tasks, multiple users are members of the signoff team. Each member is responsible for performing a signoff, but none need be the responsible party. By default, the responsible party for this task is the process initiator. But this responsibility may be configured differently at your site. The responsible party has oversight over all signoffs and has the responsibility to oversee the completion of all perform-signoffs tasks. To this end, the responsible party has permission to delegate the signoff of any signoff team member.

View signoff team profiles

The Signoff Profiles pane can be displayed only if a select-signoffs-team task or a Route task is selected.

The Signoff Profiles pane is unavailable for the Acknowledge subtask within the Route task template.

1. Click Task Properties on the toolbar.
   The Task Properties dialog box displays. The name of the selected process template or task template is listed in the Name box. Task instructions, if any, are displayed in the Instructions box. The task’s attributes display by default. Other property tabs are available in this view.

2. Click the Signoff Pane tab.
   The number or percent of signoffs required for the task to complete is listed. Also, the Wait for Undecided Reviewers check box is displayed.

3. Click Close.

Types of Workflow users

In a workflow, actions are assigned or allowed depending on the type of user.

<table>
<thead>
<tr>
<th>User</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Responsible party</td>
<td>A responsible party is the user responsible for performing a particular task within a workflow process. While performing the task, the responsible party can reassign responsibility of the task to another user. If the task is reassigned to a user other than the workflow process owner, the workflow process owner is no longer the responsible party.</td>
</tr>
<tr>
<td>Privileged user</td>
<td>A privileged user is the responsible party, the process owner, or a member of a system administration group.</td>
</tr>
</tbody>
</table>
Determining the workflow’s status

Determining task status

Each task within a workflow process is either Pending, Started, or Completed. The task’s status displays in the upper-left corner of the task.

<table>
<thead>
<tr>
<th>Symbol Example</th>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="pending-signoffs" /></td>
<td>Pending</td>
<td>The task has not yet started. A task cannot start until the previous task completes. The gray background of the task and the symbol at the top-left corner of the task indicate that the status of this task is Pending.</td>
</tr>
<tr>
<td><img src="image" alt="started-signoff-team" /></td>
<td>Started</td>
<td>The task is now active and action can be taken upon the task. The yellow background of the task and the symbol at the top-left corner of the task indicate that the status of this task is Started.</td>
</tr>
<tr>
<td><img src="image" alt="completed-review-timesheet" /></td>
<td>Completed</td>
<td>The actions required for the task are performed. A Completed state for a Review task means that all signoffs have been performed and the number of approvals are equal to that specified in the quorum for the task. The green background of the task and the symbol at the top-left corner of the task indicate that the status of this task is Completed.</td>
</tr>
</tbody>
</table>

Whenever any task in the workflow process is not explicitly assigned to another user, person or resource pool, the responsible party for the task defaults to the process owner.
The actions required for the task are not performed, but the workflow continues on as if the task is successfully performed. Only privileged users can use the Actions→Promote command to skip a task. If this is a Review task, all signoff subtasks show the No Decision image, indicating the release task was skipped, rather than completed.

The green background of the task and the symbol at the top-left corner of the task indicate that the status of this task is Skipped.

The actions required for the task are not performed, or have failed. A task’s state is set to Failed if the task is configured with a failure path and if the failure conditions are met.

The red background of the task and the symbol at the top-left corner of the task indicate that the status of this task is Failed.

A completed state for a perform-signoff task means that all signoffs have been performed, and the number of approvals are equal to the required number specified in the quorum for the task.

If the Wait For Undecided Reviewers check box is selected, the task completes when the last reviewer approves or rejects the task. If the check box is not selected, the task completes as soon as the quorum is satisfied.

A task can have the following statuses as well.

<table>
<thead>
<tr>
<th>Task state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suspended</td>
<td>The task has been suspended. If this is a Review task, all signoff tasks are removed from the Worklist.</td>
</tr>
<tr>
<td>Unassigned</td>
<td>The signoff team for a Review task is not yet assigned.</td>
</tr>
<tr>
<td>Aborted</td>
<td>The task is canceled and the workflow process is exited without being completed.</td>
</tr>
</tbody>
</table>
Viewing task flow

Task flow is both the order in which tasks are placed in the workflow process and the method by which the tasks are linked. View the task flow of a workflow process in the process flow pane. Links determine the sequence in which tasks are executed.

For example, in the following workflow process, the Update Timesheet task starts first. When it completes, the Review Timesheet task starts. This second task is a Review task, a container task containing both the select-signoff-team and perform-signoffs tasks. When both subtasks are completed, the workflow process reaches the Finish node and completes.

Success paths are indicated by a solid line. Failure paths are indicated by a dotted line. All paths are configured in the workflow template at design time.

Failure paths provide an alternate course for the workflow process to follow when:

- A task is rejected.
- The user determines that the task cannot be completed.
- There is an error.

Failure paths represent different results for different tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Failure option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do</td>
<td>Set to Unable to Complete</td>
</tr>
<tr>
<td>Review</td>
<td>Set to Reject</td>
</tr>
<tr>
<td>Route</td>
<td>Set to Reject</td>
</tr>
<tr>
<td>Condition</td>
<td>Set to Unable to Complete</td>
</tr>
<tr>
<td>Validate</td>
<td>Set to Error Path</td>
</tr>
<tr>
<td>EPM</td>
<td>Set to Unable to Complete</td>
</tr>
</tbody>
</table>

In the following workflow process, the task flow follows the success path from Review Timesheet to Revised OR Accepted when the number of reviewers defined by the quorum setting approve the timesheet.

Alternatively, the task flow follows the failure path from the Review Timesheet task to Revise Timesheet when less than the number of reviewers defined by the quorum setting approve the timesheet. This failure path allows the specified user to revise the timesheet based on reviewer comments.
Task flow can also flow backward. The following workflow process uses a **Validate** task to ensure that the correct types of target objects are always selected for a design review.

The task flow begins with a **Do** task, which sends the process initiator a instructions to ensure the workflow process was initiated against the correct target objects.

When the **Select Proper Targets** task completes, the workflow process continues to the **Validate Targets** task, which, in this example, is configured to confirm that the correct target objects were chosen for the workflow process. If the target types are correct, the process flow continues to the **Review Plan** task. If not, the process flow moves backward to the **Select Proper Targets** task.

The process initiator must once again complete the **Do** task. The process flow continues to loop until the correct target types are chosen.
Checking a task’s properties

Determining task type

Teamcenter provides different types of tasks to be used in workflow processes. Each type of task performs specific behavior. For example, Do tasks relay instructions to selected users. The instructions can be to send a shipment, mail a payroll, update a part design, or any other duty that is part of your company's business processes.

Another example is the Review task, a container task that always contains the select-signoff-team and the perform-signoffs tasks. The select-signoff-team task is sent to the worklist of the user responsible for selecting the signoff team. By default, this is the process initiator. But the responsibility might be configured differently at your site. The responsible party uses the select-signoff-team task to select the group of users responsible for signing off the target objects of the workflow process. Then each member of the signoff team receives the perform-signoffs task in their worklist. The perform-signoffs task delivers Teamcenter objects (target objects) such as documents, design parts, and so on, to the signoff team for review and required approval/rejection.

All of these types of tasks are interactive tasks.

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interactive tasks</td>
<td>Do tasks, Review tasks, and the select-signoff-team and perform-signoffs tasks are a few examples of interactive tasks. You know a task is interactive because it appears in the worklist of the user responsible for performing it.</td>
</tr>
<tr>
<td>Noninteractive tasks</td>
<td>Other tasks are noninteractive. They are performed by the system in response to handler settings, flow paths, and the results of interactive tasks. For example, the Or task is used to unite alternate paths. This task is often placed near the end of a workflow process to join together two or more branching paths. No user interaction is required to complete an Or task. Other noninteractive tasks include the Add Status and Validate tasks. When you view workflow processes in Workflow Viewer you may see these tasks. But users do not perform these tasks. Typically, they never displays in any users' worklist.</td>
</tr>
</tbody>
</table>

Each type of task is identified by a symbol in the center of the task. The following table illustrates the symbols of just a few of the types of tasks you see when viewing workflow processes in Workflow Viewer.

For a complete list of available tasks, see Workflow Viewer buttons.
### Symbol | Example | Task name | Description
--- | --- | --- | ---
🌟 | CMS Do Task | Do | Relays instructions to users to perform.

The yellow background of the task and the symbol at the top-left corner of the task indicate that the status of the task in this example is **Started**. For more information about task status, see *Determining task status*.

Review | Review Timesheet | **Review** | Controls the selecting of the signoff team, and delivers objects to the signoff team for review.

This is a container task containing both the **select-signoff-team** and **perform-signoffs** tasks. The green background of the task and the symbol at the top-left corner of the task indicate that the status of the task in this example is **Completed**. For more information about task status, see *Determining task status*.

select-signoff-team | select-signoff-team | **select-signoff-team** | Permits the process initiator to select members of the signoff team.

This is a subtask of the **Review** task. The yellow background of the task and the symbol at the top-left corner of the task indicate that the status of the task in this example is **Started**. For more information about task status, see *Determining task status*. 
### View task attributes

1. Select the task or workflow process whose attributes you want to view.

2. Click **Task Properties** on the toolbar.

   The **Task Properties** dialog box displays the name of the selected process template or task template in the **Name** box. Task instructions, if any, are displayed in the **Instructions** box.

3. Click the **Attributes** tab at the bottom of the dialog box.

   The **Task Attributes** pane appears.

   - **State** displays the selected task’s current state. A task’s state changes as you and other users proceed through workflow process activities such as performing signoffs. This cannot be modified from this dialog box.

   - **Responsible Party** displays the person responsible for the selected task. This cannot be modified from the dialog box.
• **Named ACL** displays the named ACL assigned to this task, if any. This cannot be modified from the dialog box; however, you can open the **Named ACL** dialog box for reference.

• **Signoffs Quorum** displays the number of signoffs required for a quorum to pass the selected review task. This appears only when the selected task is either **Select Signoff Team** or **Perform Signoff**. This cannot be modified from the dialog box.

• If a **Condition** task is selected, **Condition Query** displays the name of the assigned query. If a query is not yet defined, only **Condition Query** displays. If a **Condition** task is selected, **Condition Result** displays the result of the query, either **True** or **False**. If a query is not defined, the result is listed as **unset**.

• The **Due Date** button displays when completion of the task is due. You can set or change the due date in Workflow Viewer.

For more information, see **Set due date in Workflow Viewer**.

• The **Duration** box displays the length of time allowed for the completion of the project. You can set or change the duration in Workflow Viewer when the selected task is in a **Pending** state.

For more information, see **Set duration in Workflow Viewer**.

• The **Recipients** box displays the names of users selected to receive e-mail when the selected task becomes overdue. You can set or change the recipients in Workflow Viewer.

For more information, see **Set recipients list in Workflow Viewer**.

4. Click **Close**.

**Set due date in Workflow Viewer**

**Due Date** displays the date when completion of the task is due. If the task is not complete by the specified date, the task’s status changes to **late** and the task becomes overdue. Overdue tasks display in red in your worklist.

The default setting is **No date set**. The due date can be set from this dialog box.

1. Click the **Due Date** button.

   The popup calendar displays the current month.

2. Enter the date using any of the following methods:

   • Type a date directly in the box at the top.

   • Type a year in the **Year** box to change it, scroll through previous or succeeding months using the arrows, and click the desired date in the calendar display.

   • Click the **Today** button.

3. Enter the hour, minute, and second of the task completion time to the left of the respective **h; m; s** boxes. Base entries on a 24-hour clock. For example, enter 1:30 p.m. as **13 h; 30 m; 00 s**. Empty boxes automatically default to **0**.
4. Choose one of the following:
   • Click OK to save the changes to the database and close the popup calendar.
   • Click Clear to clear all settings.

   **Note** The amount of time it takes for a due date to reflect late status depends on the interval setting defined for the Task Manager daemon. This daemon can be modified in the preference XML file by editing the TASK_MONITOR_SLEEP_TIME value.

Set duration in Workflow Viewer

The Duration box displays the length of time allowed for the completion of the project. If the task is not completed within the specified amount of time, the task’s status changes to late and the task becomes overdue. The duration length can be defined in the template of the selected task. The duration length can also be defined in the Attributes dialog box when the selected task is in a Pending state.

   **Note** The Task Manager daemon must be installed to see color-coding relating to task completion.

   For more information, see the System Administration Guide.

1. Click Set to the right of the Duration box.
   The Set Duration dialog box appears.

2. Type an integer value for any or all of the following boxes to indicate the length of time that can pass before the selected task needs to reach completion:

   years
   weeks
   days
   hours
   minutes

3. Click one of the following buttons:
   • Click OK to save the changes to the database and close the dialog box.
   • Click Clear.
   • Click Cancel at any time to close the dialog box without making any changes.

Set recipients list in Workflow Viewer

Recipients displays the names of users selected to receive program mail when the selected task becomes overdue. The recipients list is set from this dialog box.

1. Click Set to the right of the Recipients box.
   The Select Recipients dialog box appears.

2. Enter the User, Group, or Address List search criteria for users you want to select.
3. Click User, Group, or Address List, based on the search criteria entered. The search results appear in the box below. To display all users in the selected grouping, type * and click the appropriate button. All users in the selected grouping display in the box below.

4. Select the users you want to define as recipients from the search results. You can choose multiple users by pressing the control key and clicking the desired names.

5. Click the To button. The selected users display in the box in the right side of the dialog box. These are the selected recipients.

6. To delete a recipient, select the recipient and click the button.

7. Click one of the following buttons:
   - Click OK to save the changes to the database and close the dialog box.
   - Click Cancel at any time to close the dialog box without making changes.

**View task attachments**

1. Click Task Properties on the toolbar.
   The Task Properties dialog box displays the name of the selected process template or task template in the Name box. This box cannot be modified from this dialog box. Task instructions, if any, are displayed in the Instructions box.

2. Click the Attachments tab at the bottom of the dialog box. The Task Attachments pane appears.
   The Task Attachments tree lists the Targets and References folders, which hold target and reference attachments, respectively.

3. Open, cut, copy, and paste attachments using the following methods:
   - Click Open to open the selected attachment in the appropriate rich client application.
   - Click Cut to cut the selected attachments to the clipboard.
   - Click Copy to copy the selected attachment to the clipboard.
   - Click Paste to paste the clipboard contents into the selected folder.

4. Click Close.

**View task handlers**

1. Click Task Properties on the toolbar.
   The Task Properties dialog box appears.
   The name of the selected process template or task template is listed in the Name box. Task instructions, if any, are displayed in the Instructions box.
2. Click the **Handlers Pane** tab.  
   The **Handlers** pane appears.  
   For more information about task handlers, see the *Workflow Designer Guide*.  

3. Click the **Expand All Folders** or **Collapse All Folders** button to view the contents of the **Handlers Hierarchy** tree.  
   Based on the type of handler selected, either the **Rule Handler** or **Action Handler** pane appears, listing the name of the rule handler or action handler assigned to the selected task.  
   If the selected task involves selecting signoff teams or performing signoffs, a **Quorum** box contains the number of approvals required for a quorum.  
   The arguments assigned to the selected task are in the **Argument** list.  

4. Click **Help** for documentation on the selected handler.  

5. Click **Close** to close the dialog box.

### View audit information

**Viewing audit information**

You can view audit information in the following ways:  
- Go to the **Summary** view of the following Teamcenter applications, which shows audit logs in the **Audit logs** tab.  
  o My Teamcenter  
  o ADA License  
  o Structure Manager  
  o Multi-Structure Manager  
  o Manufacturing Process Planner  
  o Schedule Manager  
  o Workflow Viewer  
  o Organization  
   For more information, see *View audit logs in the Summary view*.  

- Run predefined audit reports or create new reports, using the Report Builder application.  
  For more information, see *My Teamcenter Guide*.  

- Create custom saved queries, using the Query Builder application.  
  For more information, see *Creating and running audit queries*.  

---

**Viewing workflows**
Chapter 2 Viewing workflows

- Run predefined audit queries, using the Teamcenter advanced search functionality.

View audit logs in the Summary view

- The **Summary** view of the following Teamcenter applications shows audit logs in the **Audit logs** tab.
  - My Teamcenter
  - ADA License
  - Structure Manager
  - Multi-Structure Manager
  - Manufacturing Process Planner
  - Schedule Manager
  - Workflow Viewer
  - Organization

Legacy audit information is only accessible from a button in the **Audit Logs** tab in the **Summary** view when a legacy audit file is present.

The audit logs are grouped in the **Summary** view as follows:

<table>
<thead>
<tr>
<th>Log name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Logs</td>
<td>Displays workflow logs.</td>
</tr>
<tr>
<td>License Change Logs</td>
<td>Displays logs of ADA License changes.</td>
</tr>
<tr>
<td>License Export Logs</td>
<td>Displays ADA License export logs.</td>
</tr>
<tr>
<td>File Access Logs</td>
<td>Displays file access logs.</td>
</tr>
</tbody>
</table>
Log name | Description
---|---
Structure Logs | Displays structure logs.

**Note** Due to performance reasons, PSOccurrence audit logs are not immediately displayed in the Structure Logs table. To view the PSOccurrence audit logs, refresh the table.

Organization Logs | Displays organization logs.
Schedule Logs | Displays schedule logs.
General Logs | Displays all other general audit logs.

Process reports

The following audit reports are available when you choose the Tools→Reports→Report Builder Reports menu command in My Teamcenter:

- **Audit - Workflow Attachment Report**  
  Displays all attachment object details for the specified workflow process.

- **Audit - Workflow Detailed Report**  
  Displays all actions and their statuses for the specified workflow process.

- **Audit - Workflow Signoff Report**  
  Displays the signoff results and comments for the specified object in a workflow process.

- **Audit - Workflow Summary Report**  
  Displays the start, complete, approve, rejected, release status, demote, promote, fail, and update actions for the specified workflow process.

- **WF - Filtered Audit**  
  Displays the start, complete, approve, and rejected actions for the specified workflow process. For more detailed information about this set of actions, including group and role of the performer and assignee information, use **Audit - Workflow Summary Report**.

- **WF - Items In Process**  
  Displays the *items* currently in a workflow process and where they are in their respective processes.

- **WF - Objects In Process**  
  Displays the *objects* currently in a workflow process and where they are in their respective processes.

- **WF - Signoffs**  
  Displays the signoff results and comments for the specified object in a workflow process. For more detailed information, use **Audit - Workflow Signoff Report**.
Chapter 2  Viewing workflows

- **WF - Unfiltered Audit**
  Displays all actions and their statuses for the specified workflow process. For more detailed information about this set of actions, including group and role of the performer and assignee information, use **Audit - Workflow Detailed Report**.

**Creating and running audit queries**

You can create custom search queries for audit logs, using the Query Builder application. Saved queries identify the search criteria that are used to find information in Teamcenter:

For more information about creating saved queries, see the **Query Builder Guide**.

For information about running saved queries, see the **Rich Client Interface Guide**.

**Note** Ensure that audit definitions exist for the objects for which you have created saved queries.

Teamcenter provides the following predefined audit queries:

- **Audit - File Access Logs**
- **Audit - General Logs**
- **Audit - License Change Logs**
- **Audit - License Export Logs**
- **Audit - Organization Logs**
- **Audit - Project Based Logs**
- **Audit - Schedule Logs**
- **Audit - Workflow Attachment Logs**
- **Audit - Workflow Detailed**
- **Audit - Workflow Signoff**
- **Audit - Workflow Summary**

**Export audit logs to Microsoft Excel**

1. Run a saved query and choose the audit logs you want to export from the Details tab.
2. Choose **Tools→Export→Objects To Excel**.
   Teamcenter displays the **Export To Excel** dialog box.
3. Under **Object Selection**, click one of the following:
   - Click **Export Selected Objects** to export the selected rows in the view.
   - Click **Export All Objects in View** to export all rows.
4. Under **Output Template**, select one of the following:
   - Select **Export All Visible Columns** to export all the columns in the view.
   - Select **Use Excel Template** to activate the template list.
     
     In the list, select the **AUDIT_log_excel_template_new** template.

5. Under **Output**, click **Static Snapshot**

6. Click **OK** to generate the export Excel file.

Microsoft Excel opens a temporary file. You can create a permanent file by choosing **File→Save As** in Excel to display the **Save As** dialog box.

If you save a live Excel file, you can open it later in My Teamcenter to reconnect it to the database.

**Note**  
Values that you cannot change in Teamcenter are unavailable in the cells of the live Excel file.

The export to Excel option is not available on UNIX clients.

### View legacy audit log information

**Note**  
This data is available only if the **TC_audit_manager** preference is set to **ON** and the **TC_audit_manager_version** preference is set to **2**.

1. (Optional) Select an object in the tree.

2. Choose **View→Audit→View Audit Logs**.
   
   OR
   
   Right-click an object in My Teamcenter and choose **View Audit Logs**.

   The system displays the **Audit Log** dialog box.

   - If you select an object, the object ID, name, revision, and object type are displayed in the **Search Criteria** section.

   - To select a project, select a project you have access to from the **Project** list.

   - If you want to search for a different object, click the **Clear** button to clear the existing search criteria and then type the object ID, name, and revision in the **Audit Log** dialog box.

3. (Optional) Specify additional search criteria, such as event type, user ID, and date created.

4. (Optional) Click the **Advanced** tab and type criteria to construct a query based on property values.

**Note**  
The **Advanced** tab does not display any information if there are no logged properties in the audit definition object.
a. Select an object type from the **Object Type** list.
   After you select an object type, the **Event Type** list is enabled.

b. Select an event type from the **Event Type** list.
   The logged properties defined in the audit definition object are shown in the **Available Properties** list.

c. Select the properties for which you require audit logs from the **Available Properties** list, and click the **+** button to move the property to the **Selected Search Criteria** list.

   **Note** You can add up to 20 properties in the **Selected Search Criteria** list.

d. To search for properties based on old or new values, in the **Selected Search Criteria** list, enter the old value in the **Old Value** column and the new value in the **New Value** column.

e. Click **Find**.
   Audit logs that match your selected criteria appear.

5. Click **Find**.
The system displays the audit logs that match the search criteria. Property value changes are shown in the User Data column of the audit log. The User Data column shows the property name, the old value of the property, and the new value of the property. The old value of the property is the same as the new value of the property if the property value does not change.

**Note** Only persistent properties of objects are tracked. Run-time, compound, and relational properties are not tracked by Audit Manager.

**Viewing workflow and schedule progress**

**Reviewing workflow and schedule progress by viewing the process history**

The Process History view displays the Workflow or Schedule Manager process of the business object selected in the Home, My Worklist, or Search Results view in My Teamcenter.
• If there is no audit data for the business object, the view displays a No process history data available for selected object. message.

• If the selected object has passed through more than one workflow process, you can choose which process to display from the list to the right of the tab.

In the Process History view, you can review the progress of a workflow or schedule and do the following:

• Determine the progress of an object in a schedule or workflow and who has responsibility for the object.

• Review comments by other workflow participants.

• Verify that the appropriate participants completed the required reviews.

• Debug a workflow that proceeded down an unexpected path.

• Identify workflows that require attention to continue processing.

• Review user activity to verify the appropriate users signed off.

Customize the process history display

1. In the Process History view, click the View Menu button ▼ and then choose Column from the view menu.

   The Column Management dialog box appears.

2. Add or remove columns from the Process History view table.

   • To add a column, select a property from the Available Properties list and click the Add to Displayed Columns button ▼.

   • To remove a column, select a property in the Displayed Columns list and click the Remove from Displayed Columns button ▼.
3. (Optional) Click the **Move Up** and **Move Down** buttons, to the right of the **Displayed Columns** list, to adjust the order of the displayed columns.

4. Click **Apply** to apply the configuration to the current view, or click **Save** to save the configuration for later use.

   **Note** You can use the **Apply Column Configuration** command on the view menu to:
   - Apply a saved configuration.
   - Restore the default configuration. This is the only way to restore columns removed using the right-click **Remove this column** command.

   You can use the **Save Column Configuration** command on the view menu to save the current configuration of the table display.

5. Click **Close** to close the **Column Management** dialog box.

### Process reports

The following audit reports are available when you choose the **Tools→Reports→Report Builder Reports** menu command in My Teamcenter:

- **Audit - Workflow Attachment Report**
  Displays all attachment object details for the specified workflow process.

- **Audit - Workflow Detailed Report**
  Displays all actions and their statuses for the specified workflow process.

- **Audit - Workflow Signoff Report**
  Displays the signoff results and comments for the specified object in a workflow process.

- **Audit - Workflow Summary Report**
  Displays the start, complete, approve, rejected, release status, demote, promote, fail, and update actions for the specified workflow process.

- **WF - Filtered Audit**
  Displays the start, complete, approve, and rejected actions for the specified workflow process. For more detailed information about this set of actions, including group and role of the performer and assignee information, use **Audit -Workflow Summary Report**.

- **WF - Items In Process**
  Displays the *items* currently in a workflow process and where they are in their respective processes.

- **WF - Objects In Process**
Chapter 2 Viewing workflows

Displays the objects currently in a workflow process and where they are in their respective processes.

- **WF - Signoffs**
  Displays the signoff results and comments for the specified object in a workflow process. For more detailed information, use Audit - Workflow Signoff Report.

- **WF - Unfiltered Audit**
  Displays all actions and their statuses for the specified workflow process. For more detailed information about this set of actions, including group and role of the performer and assignee information, use Audit - Workflow Detailed Report.

Print the process history report

1. Export the audit report to Excel.
   For more information, see Export audit logs or process history to Microsoft Excel.
2. Use Excel’s print function to print the report.

Export audit logs or process history to Microsoft Excel

1. Display the Process History view and choose the rows you want to export.
   OR
   Run a saved query and select the audit logs you want to export from the Details tab.
2. Choose Tools→Export→Objects To Excel.
   Teamcenter displays the Export To Excel dialog box.
3. Under Object Selection, select one of the following:
   - Select Export Selected Objects to export the rows you selected in the view.
   - Select Export All Objects in View to export all rows.
4. Under Output Template, select one of the following:
   - Select Export All Visible Columns to export all the columns in the view.
   - Select Use Excel Template to activate the template list.
     In the list, select the template that specifies the data that you want to export.
5. Under Output, select one of the following:
   - For a standard Excel file that is not connected to Teamcenter, select Static Snapshot.
   - For an interactive live Excel file that is connected to Teamcenter, select Live integration with Excel (Interactive).
   - For a live Excel file that is not connected to Teamcenter, select Live integration with Excel (Bulk Mode).
You can accumulate changes and later connect the file to Teamcenter.

- To export the data to an Excel file that also contains import processing information on a separate sheet, select **Work Offline and Import**.

- To check out objects while exporting to live Excel, select **Check out objects before export**.

  **Note** The checkout applies to all objects being exported. Use this option carefully if you are exporting a large number of rows.

6. (Optional) Click **Copy URL**.

   **Note**
   - **Copy URL** is unavailable if you select more than one object to export.
   - **Copy URL** is unavailable if you select any of the following dialog box options:
     - Work Offline and Import
     - Export All Visible Columns
     - Export All Objects in View

The export file is generated and the **URL Generated** message is displayed, confirming that the URL is in your Windows Clipboard and showing the URL details.

7. Click **OK** to generate the export Excel file.

Excel opens a temporary file. You can create a permanent file by choosing **File→Save As** in Excel to display the **Save As** dialog box.

If you save a live Excel file, you can open it later in My Teamcenter to reconnect it to the database.

**Note** Values that you cannot change in Teamcenter are unavailable in the cells of the live Excel file.
Chapter

3 Using ad hoc process modification

Modifying active workflow processes .................................................. 3-1
Ad hoc modification ............................................................................... 3-1
Edit an active workflow process .............................................................. 3-2
What are workflow subprocesses? .............................................................. 3-4
Create a workflow subprocess ................................................................. 3-4
Stopping a workflow process in Workflow Viewer ................................... 3-6
Chapter

3 Using ad hoc process modification

Modifying active workflow processes

Workflow Viewer allows privileged users to modify active workflow processes one template at a time. Privileged users can add, remove, rearrange and modify tasks, flow paths, handlers, and other elements of the workflow process template while workflow processes based on the template are running.

This functionality is called ad hoc process modification. It is available using the application’s Design mode.

Enable this functionality, and control user access, by setting the WORKFLOW_adhoc_process preference. Access can be granted to all users, group administrators, and/or system administrators.

For more information about this preference, see the Preferences and Environment Variables Reference.

Note Alternatively, to update many active workflow processes simultaneously, use Workflow Designer application. You apply workflow template edits to all active workflow processes based on the previous (unedited) version of the workflow template.

For more information about using Workflow Designer to update active workflow processes, see the Workflow Designer Guide.

Ad hoc modification

Adding or deleting tasks from a workflow process while it is active is called ad hoc modification. In Workflow Viewer, this ad hoc ability is possible whenever you are in Design mode.

To modify a task template, it must be in one of the following states:

- Unassigned
- Pending
- Suspended
- Completed

Note You can modify a Completed task only if the configuration of the template allows the task to rerun, such as for backward-branching loops. The modification takes effect when the task is restarted.

To modify a task, it cannot be in any of the following states:

- Aborted
- Failed
Chapter 3  Using ad hoc process modification

The **Failed** state does not appear on the **Actions** menu, because it can only be triggered internally.

**Skipped**  
**Started**

**Note** If you want to modify a **Started** task, you must suspend it first.

Edit an active workflow process

1. Open the active workflow process you want to edit in Workflow Viewer. Do so by locating an object involved in the workflow process using one of the following methods:
   - Select a task involved in the workflow process you want to edit from your worklist.
   - Use **Search** to locate an object you know is involved in an active workflow process, or to search for all objects currently in-process.
     For information about using the quick **Search** box to locate objects and using the **Select search** button on the **Search** pane toolbar, see the **Rich Client Interface Guide**.
   - Send an object you know is involved in an active workflow process to the **Impact Analysis** view and perform a **Where Referenced** search to display all references to the object, including all referenced workflow processes.
     For information about using the **Where Referenced** functionality, see the **Rich Client Interface Guide**.

2. Right-click the object and choose **Send To→Workflow Viewer**. Or, if performing a **Where Referenced** search, right-click the active workflow process and choose **Send To→Workflow Viewer**.
   The active workflow process is opened in Workflow Viewer.

3. If the task you want to edit is active, right-click the task and choose **Actions→Suspend**.
   The **Suspend Action Comments** dialog box appears.
   a. Type your comments into the dialog box. The comments are listed in the audit file.
   b. Click **OK**.
      The selected task moves to the **Suspend** state, and a red light button appears in the upper left corner.

4. Choose **Edit→Mode→Design** to enable ad hoc functionality.
   The following message appears:

   *Note that changing the Workflow Viewer Application mode to "Design" will lock this process, and allow you to modify the Process Structure and Handlers! Do you want to continue?*
5. Click **Yes** to lock the selected workflow process within the database and proceed with modifying the workflow process. No other users can perform tasks for this workflow process until you have unlocked the workflow process by returning to **Execute** mode. Click **No** to discontinue without making changes.

6. (Optional) Add, place, and remove tasks as described in **Workflow Designer Guide**.

7. (Optional) Add, remove, and modify task attributes by clicking the **Task Attributes** button.
   For more information, see **View task attributes**.

8. (Optional) Add, remove, and modify task attachments by clicking the **Task Attachments** button.
   For more information, see **View task attachments**.

9. (Optional) Edit task handlers by clicking the **Task Handlers** button.
   For more information, see **View task handlers**.

10. (Optional) Edit perform signoff teams by clicking the **Task Signoff** button.
    
    **Note** Signoff profiles are unavailable for the **Acknowledge** subtask within the **Route** task template. The **Route** task does not function properly if a signoff profile is defined for the **Acknowledge** subtask. The **Route** task template is designed to be used as an electronic routing sheet, and the workflow process initiator assigns specific signoff members.
    
    For more information, see **View signoff team profiles**.

11. Choose **Edit→Mode→Execute** to return to **Execute** mode.
    
    The following message appears:
    
    ```plaintext
    Note that changing the Workflow Viewer Application mode from "Design" to "Execute" will unlock this process. Do you want to commit any Design changes you made?
    ```

12. Click **Yes** to unlock the selected workflow process within the database. Any changes you made to the workflow template are implemented.
    
    Click **No** to unlock the selected workflow process within the database. Any changes you made to the workflow template are *not* implemented.
    
    Click **Cancel** to remain in **Design** mode.

13. If you suspended the task to edit it, right-click the task and choose **Actions→Resume**.
    
    The **Resume Action Comments** dialog box appears.
    
    a. Type your comments into the dialog box. The comments are listed in the audit file.
    
    b. Click **OK**.
    
    The selected task moves to the state it was in prior to the **Suspend** action.
Chapter 3  Using ad hoc process modification

What are workflow subprocesses?

Subprocesses are child workflow processes of a parent workflow process. You can create subprocesses while performing tasks from your worklist. When created in this manner, parent workflow processes are dependent on subprocesses; they cannot complete until the subprocess completes.

A typical scenario is one in which you receive a task in your worklist that is dependent upon the completion of an additional workflow process. You decide to create a workflow subprocess to track the work which must be completed before you can complete the task in the parent workflow.

Generally, any user can create a workflow subprocess from a task within their worklist. This functionality is not limited to privileged users.

When you create a workflow subprocess from an in-process task in your worklist, you create a dependency between the selected task in the parent process and the newly created subprocess. The targets of the active parent workflow process are carried over if you check the Inherit Targets box.

Create a workflow subprocess

You can create workflow subprocesses while performing tasks from your worklist or Workflow Viewer.

For information about using the rich client to create workflow subprocesses from My Worklist in My Teamcenter, see the My Teamcenter Guide.

For information about using the thin client to create workflow subprocesses from My Worklist, see the Thin Client Interface Guide.

To create workflow subprocesses while performing tasks from Workflow Viewer:

1. In the Task hierarchy tree, select the task in the existing workflow from which you want to create a subprocess.

   The task you select becomes dependent upon the workflow subprocess. It cannot complete until the workflow subprocess completes.

2. Right-click the task and choose Create New Workflow Sub-Process.

   The New Sub-Process dialog box appears.

3. Type a name for the process in the Sub-Process Name box.

4. Type a description to identify the process in the Description box.

5. (Optional) Select a Process Template Filter option.
   - To include process templates currently under construction in the Process Template list, select the Show Under Construction Templates check box.
   - To display all available process templates in the Process Template list, select All.
   - To display only those process templates assigned to your group in the Process Template list, select Assigned.
6. Click the **Process Template** list to view available workflow process templates and make a selection.

   Your selection determines the workflow that will be initiated as a workflow subprocess.

7. (Optional) Select the **Inherit Targets** check box if you want the new workflow subprocess to include all the targets of the parent workflow process.

8. (Optional) Click the **Attachments** tab to view or assign target and reference attachments.

9. (Optional) Click the **Process Template** tab to view the process template selected as the basis of the new process.

10. (Optional) Assign all tasks in the process.
    a. Click the **Assign All Tasks** tab.
    b. Select a list from the **Assignment Lists** list.

    Teamcenter applies the assignment list to the tasks in the process. Users are displayed as nodes in the process tree and the action assigned to the user is displayed to the right of the tree under the **Actions** heading.

    **Note** The select-signoff-team and perform-signoffs subtasks associated with **Route**, **Review**, and **Acknowledge** tasks are not displayed in the tree.

    c. Assign users:

       A. Expand the task node in the tree to begin to assign the responsibility of performing each task to users.

       If the selected task requires users, or users of a specific/group role profile, to perform the task, the **Users** node or **Profiles** node appears under the task.

       B. Select the task, or if available, the **Users** or **Profiles** node within the task.

       C. Use the **Organization** and **Project Teams** trees to select users to be responsible for performing the selected task.

       D. Alternatively, use **Resource Pool Options** to select a resource pool to be responsible for performing the task.

       E. The action that the selected users are responsible for display next to the **Action** option.

       The action list is based on the task type. For example, if a **Route** task is selected, the **Review**, **Acknowledge**, and **Notify** actions are displayed. If a **Review** task is selected, only the **Review** action is available; if an **Acknowledge** task is selected, only the **Acknowledge** action is available.

       F. Click **Add**.

       The system displays the user information and action assigned to that user beneath the task node in the process tree.
G. Repeat the previous steps to continue to assign user responsibility for performing other tasks in the tree.

d. (Optional) If the selected task is a Review or Acknowledge task, you can set the approval quorum values for the tasks in the Review Quorum or Acknowledge Quorum box.

e. (Optional) If the selected task is a Review or Acknowledge task, specify that you do not want the task to complete until all reviewers perform their signoff by selecting the Wait For Undecided Reviewers check box. If you do not select this check box, the task completes as soon as the approval quorum is satisfied.

f. (Optional) To save modifications to the process assignment list, select the Save Modifications Back to List check box.

Note You can only save modifications to personal process assignment lists. Shared lists can be modified, but the changes cannot be saved.

11. Click OK to initiate the process.

Note Click Cancel at any time to cancel the operation without initiating a process.

Stopping a workflow process in Workflow Viewer

There are three ways to stop a workflow process in Workflow Viewer:

• Suspend
  Stops the process from moving forward. Choose Actions→Suspend. You can resume a suspended process by choosing Actions→Resume.

• Abort
  Cancels the process, but keeps the process in the system. Choose Actions→Abort.

• Delete
  Removes the process from the system. Choose Edit→Delete.

If you have a subprocess attached to your workflow process, the following rules apply when you delete or abort the parent process or subprocess:

• Delete or abort the parent process.
  o If the parent process is the only parent for the subprocess, the subprocess is also deleted or aborted.
  o If there is more than one parent process for the subprocess, the subprocess is not deleted nor aborted unless it is the last parent process.

• Delete or abort a subprocess—the parent process is kept.

• Delete the task in the parent process that originates the subprocess—the subprocess is not affected.
• If the subprocess has its own subprocess, it follows the rules above.
4 Tasks you can perform

Performing tasks in Workflow Viewer ........................................... 4-1
Selecting a signoff team ................................................................. 4-2
  Selecting a signoff team in Workflow Viewer ................................. 4-2
  Select Signoff Team dialog box ..................................................... 4-3
  Select a signoff team from profiles .............................................. 4-4
  Select a signoff team ad hoc ....................................................... 4-5
  Select a signoff team from address lists ..................................... 4-6

Signing off an Acknowledge or Review task ................................. 4-7
  Signing off an Acknowledge or Review task ................................ 4-7
  Perform a signoff of an Acknowledge task in Workflow Viewer ........ 4-7
  Sign off a Review task in Workflow Viewer ................................. 4-10

Perform a Do task in Workflow Viewer ........................................... 4-12
Perform a Condition task manually in Workflow Viewer .................... 4-13
Perform a Route task in Workflow Viewer ..................................... 4-15
Perform a Custom task in Workflow Viewer ................................... 4-16
Reassign a task in Workflow Viewer ............................................. 4-16
Claim a task ................................................................................. 4-17
Chapter

4 Tasks you can perform

Performing tasks in Workflow Viewer

You can perform any interactive task from Workflow Viewer that is assigned to you and currently active. In other words, any task you can perform from My Worklist you can perform from Workflow Viewer.

Your My Worklist view is streamlined to display only tasks that are ready to be performed. Because Workflow Viewer displays the entire workflow process, selecting tasks to perform requires a basic understanding of the different task statuses in a workflow process.

Example

The following workflow process indicates that the Change Admin I task is complete ✔️. You can no longer perform this task. The Author Technical Recommendation task has started 📂 and can be performed.

The Author Technical Recommendation task is a Review task. Review tasks are container tasks; they always contain two subtasks, a select-signoff-team subtask and a perform-signoffs subtask.

You must expand the Review task to view the status of the two subtasks and determine which subtask is ready to be performed. You can expand
container tasks from either the task tree or by double-clicking the task within the process flow pane.

<table>
<thead>
<tr>
<th>Expansion method</th>
<th>Container task</th>
<th>Container task expanded</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task tree</td>
<td><img src="image" alt="Task Tree Example" /></td>
<td><img src="image" alt="Task Tree Expanded Example" /></td>
</tr>
<tr>
<td>Process flow pane</td>
<td><img src="image" alt="Process Flow Pane Example" /></td>
<td><img src="image" alt="Process Flow Pane Expanded Example" /></td>
</tr>
</tbody>
</table>

Using either method to expand the Author Technical Recommendation task reveals that the select-signoff-team task is started and can be performed, and that the perform-signoffs task is pending and cannot yet be performed.

For more information about task status, see *Determining task status*.

**Selecting a signoff team**

**Selecting a signoff team in Workflow Viewer**

To perform a select-signoff-team task, the responsible party selects users to be members of the signoff team. Each member of the signoff team is responsible for reviewing and signing off on the attached target objects. They do this using the perform-signoffs task, which is sent to their worklist as soon as the signoff team is selected.

There are three methods of selecting a signoff team.

<table>
<thead>
<tr>
<th>Selection method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profiles</td>
<td>Select the specified number of users to be members of the signoff team or use a resource pool. Each user must meet the group and role requirements of the profile. In this example, you must select one user from the Change Specialist group, of any role. (The * is a wildcard.) You must select three users from the Engineering group with the role of Designer. (Profile requirements can be met using resource pools, as well as individual members.) The OK button in the Select Signoff Team dialog box remains unavailable until you...</td>
</tr>
</tbody>
</table>
### Selection method

<table>
<thead>
<tr>
<th>Selection method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Select any number of users, from any group and role, to be members of the signoff team. This is an ad hoc selection method. You can also select resource pools.</td>
</tr>
<tr>
<td>Address lists</td>
<td>Select all the members of one or more address lists to be members of the signoff team. You can also select resource pools.</td>
</tr>
</tbody>
</table>

If the **Ad-hoc done** check box is enabled at the bottom of the Select Signoff Team dialog box, you can use this selection method, regardless of whether you also use the profiles and address list methods.

### Select Signoff Team dialog box

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signoff Team tree</td>
<td>Lists the members of the signoff team. When you click Users in the Signoff Team tree, the Organization pane appears. When you click Address Lists in the Signoff Team tree, the Address Lists pane appears. Profiles lists the required group/role of the signoff team member and quorum requirement.</td>
</tr>
<tr>
<td>Review Quorum</td>
<td><strong>Numeric</strong>: Enter the number of reviewers required to approve to satisfy the quorum. <strong>Percent</strong>: Enter the percentage of reviewers that are required to approve to satisfy the quorum. If all reviewers are required, set Percent to 100. <strong>Comments</strong>: Enter comments (optional). <strong>Wait for Undecided Reviewers</strong>: Select this check box for the workflow process to wait for all reviewers before the workflow process completes.</td>
</tr>
<tr>
<td>Ad-hoc done</td>
<td>Indicates you have completed adding signoff team member assignments to this task.</td>
</tr>
<tr>
<td>Dynamic Selection pane</td>
<td>Changes based on the selections made in the Signoff Team tree.</td>
</tr>
</tbody>
</table>
### Chapter 4  
*Tasks you can perform*

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization tab</td>
<td>Lists the <strong>Organization</strong> tree by group and then by role.</td>
</tr>
<tr>
<td>Project Teams tab</td>
<td>Lists the project teams available for selection.</td>
</tr>
<tr>
<td>Address Lists</td>
<td>Lists the address lists available for selection</td>
</tr>
<tr>
<td>Resource Pool Options</td>
<td>Choose either <strong>Any Member</strong> or <strong>All Members</strong> of the signoff team. buzzing in French: Choose either <strong>Specific Group</strong> or <strong>Any Group</strong> of the signoff team.</td>
</tr>
<tr>
<td>Search</td>
<td>Search for a specific user.</td>
</tr>
<tr>
<td>Add button</td>
<td>Allows you to add your selection to the signoff team.</td>
</tr>
</tbody>
</table>

### Select a signoff team from profiles

1. Select a **select-signoff-team** task that has reached **Started** status, either in the task hierarchy tree or the process flow pane.

2. Review any task instructions written in the **Instructions** box, at the bottom of the template manager pane.

3. **(Optional)** If you know you have additional tasks to perform before you can perform the **select-signoff-team** task, you can create a subprocess from this task. The subprocess must complete before the **select-signoff-team** task can complete.
   
   For more information about creating a subprocess, see *Create a workflow subprocess*.

4. Click **Perform Task** on the toolbar or the button in the middle of the task in the process flow pane.
   
   The **Select Signoff Team** dialog box appears.

5. Expand the **Profiles** folder in the **Signoff Team** tree.

6. Select a profile. The **Organization** tab displays to the right, filtered to the group and role required by the selected profile.

7. Search or select a user from the **Organization** tree. You can assign a resource pool to the task in **Resource Pool Options**.
   
   For more information about using and defining resource pools, see the *My Teamcenter Guide*.

8. Click **Add** to add the selected user to the signoff team.
   
   The user name is added under the selected profile.

9. Repeat these steps to assign additional users to the signoff process. You must select the specified number of users, of the specified group and role, for each profile.
Tasks you can perform

For example, if the profile states: Engineering/Designer/3, you must select three users from the Engineering group, with the role of Designer.

All profiles must be satisfied before the select-signoff-team task can complete.

10. (Optional) Type a description of the workflow process in the Process Description box.

11. (Optional) From the Review Quorum box, select the amount of users who must approve in order for the task to complete. The initial setting is inherited from the process template. If you want to change that setting, select a quorum using one of the following methods:
   - Select the Numeric option and type a number in the box.
   - Select the Percent option and type a percentage in the box.

12. (Optional) Type any comments regarding the task in the Comments box.

13. If you want the workflow process to wait for all reviewers before continuing, select the Wait for Undecided Reviewers check box.

14. Click Ad-hoc done to indicate you have completed adding signoff team members.

15. Click OK to complete the task and close the dialog box.

Select a signoff team ad hoc

1. Select a select-signoff-team task that has reached Started status, either in the task hierarchy tree or the process flow pane.

2. Review any task instructions written in the Instructions box, at the bottom of the template manager pane.

3. (Optional) If you know you have additional tasks to perform before you can perform the select-signoff-team task, you can create a subprocess from this task. The subprocess must complete before the select-signoff-team task can complete.
   For more information about creating a subprocess, see Create a workflow subprocess.

4. Click Perform Task on the toolbar.
   The Select Signoff Team dialog box appears.

5. Click Users in the Signoff Team tree.
   The Organization tab displays to the right.

6. Search and select a user from the Organization tree. You can assign a resource pool to the task in the Resource Pool Options.
   For more information about using and defining resource pools, see the My Teamcenter Guide.

7. Click Add to add the selected user to the signoff team.
8. Repeat these steps to assign additional users to the signoff process.

9. (Optional) Type a description of the workflow process in the Process Description box.

10. (Optional) From the Review Quorum box, select the amount of users who must approve in order for the task to complete. Select a quorum using one of the following methods:
    • Select the Numeric option and type a number in the box.
    • Select the Percent option and type a percentage in the box.

11. (Optional) Type any comments regarding the task in the Comments box.

12. If you want the workflow process to wait for all reviewers before continuing, select the Wait for Undecided Reviewers check box.

13. Click Ad-hoc done to indicate you have completed adding signoff team members.

14. Click OK to complete the task and close the dialog box.

Select a signoff team from address lists

1. Select a select-signoff-team task that has reached Started status, either in the task hierarchy tree or the process flow pane.

2. Review any task instructions written in the Instructions box, at the bottom of the template manager pane.

3. (Optional) If you know you have additional tasks to perform before you can perform the select-signoff-team task, you can create a subprocess from this task. The subprocess must complete before the select-signoff-team task can complete.

   For more information about creating a subprocess, see Create a workflow subprocess.

4. Click Perform Task on the toolbar.

   The Select Signoff Team dialog box appears.

5. Click Address Lists in the Signoff Team tree.

   The Address Lists tab displays to the right.

6. Select an address list from the list to display the members of the address list.

7. Click Add.

   All members of the address list appears under Addresses in the Signoff Team tree.

8. Repeat these steps to add additional address lists.

9. (Optional) Type a description of the workflow process in the Process Description box.
Tasks you can perform

10. (Optional) From the Review Quorum box, select the amount of users who must approve in order for the task to complete. Select a quorum using one of the following methods:
   - Select the Numeric option and type a number in the box.
   - Select the Percent option and type a percentage in the box.

11. (Optional) Type any comments regarding the task in the Comments box.

12. If you want the workflow process to wait for all reviewers before continuing, select the Wait for Undecided Reviewers check box.

13. Click Ad-hoc done to indicate you have completed adding signoff team members.

14. Click OK to complete the task and close the dialog box.

Signing off an Acknowledge or Review task

Signing off an Acknowledge or Review task

To perform a signoff task, complete the selected perform-signoffs task in the task tree. There are two types of perform-signoffs tasks:

- Review signoffs, with which the user can elect to Approve, Reject, or make No Decision for the selected task.

- Acknowledge signoffs, with which the user can elect to Acknowledge or Not Acknowledge the selected task.

Only members of the signoff team can sign off a task.

Note: Siemens PLM Software recommends using your worklist in My Teamcenter to perform signoffs, as the worklist is designed specifically for performing tasks. If you are a responsible party, the Perform Signoff task is automatically sent to the Tasks to Perform folder in your worklist.

Information most pertinent to a signoff task is displayed in the Perform Signoff dialog box. The process name, task name, and task state are listed at the top of the dialog box. View any comments and instructions by clicking the respective links. Additional task information, such as task attributes, is displayed in other dialog boxes.

Click any linked entry to display its related dialog box. For example, click a linked entry in the Decision column to display the Signoff Decision dialog box and make your signoff decision.

Tool tips are available for each column in the dialog box. Activate the tool tips by moving your cursor over each column.

Perform a signoff of an Acknowledge task in Workflow Viewer

1. Select the perform-signoffs task to be completed, either in the task hierarchy tree or the process flow pane.
Chapter 4  Tasks you can perform

2. (Optional) If you know you have additional tasks to perform before you can perform the perform-signoffs task, you can create a subprocess from this task. The subprocess must complete before the perform-signoffs task can complete.

   For more information about creating a subprocess, see Create a workflow subprocess.

3. Click Perform Task ✔ on the toolbar.

   The Perform Signoff dialog box appears. The process name and task state appear at the top of the dialog box.

4. Review the contents of the Process Description box. If necessary, type additional information into the box.

5. If the Responsible Party entry contains a link, you can reassign the responsible party for this signoff task.

   a. Click the linked user name next to the Responsible Party entry.

      The Assign Responsible Party dialog box appears.

   b. The Organization and Project Teams tabs display the available groups, roles, and users to which you can reassign the role of responsible party.

   c. Select the desired group, role, or user and click OK.

      The task is reassigned to the selected responsible party and the dialog box closes.

6. If the All Comments entry is linked, comments have been written regarding this signoff task. View the comments by clicking the linked entry. The All Comments dialog box appears. Any comments that have been written by yourself and other users are displayed within the text box.

7. View attachments to the workflow process by clicking the Attachments link.

   The Attachments dialog box appears. Target and reference attachments are listed below the signoff task in the task tree.

8. If the Instructions entry appears, instructions have been written for this signoff task. View the instructions by clicking the linked entry.

   The Instructions box appears. All task instructions are displayed within the text box.

9. (Optional) If you do not want to perform this signoff, delegate the signoff task to a different user.

   a. Click on your user name in the User-Group/Role column.

      The Delegate Signoff dialog box appears.

   b. The Organization and Project Teams tabs display the available groups, roles, and users to which you can delegate your signoff responsibility.

   c. Select the desired group, role, or user and click OK.
Your signoff responsibility is delegated to the selected user and the dialog box closes. The perform-signoffs task is removed from your worklist, and sent to the worklist of the selected user.

**Note** Signoff responsibility can also be delegated by the responsible party, or a member of the System Administration group.

10. Perform any signoff assigned to you. You can perform any entry in the Decision column that is linked. Typically, you are only listed once. However, it is possible that you hold multiple entries within the signoff team, for various groups or roles.

a. Click a linked entry in the Decision column. By default, all entries begin as **Not Acknowledged**.

The Signoff Decision dialog box appears.

b. Select either Acknowledged or Not Acknowledged from the Decision section of the dialog box.

c. Type any comments regarding your in the Comments box. It is particularly useful to include comments when you reject a signoff.

d. Click OK.

The signoff decision is recorded and the dialog box closes.

**Note** You must be a member of the group/role required by the signoff task to perform a signoff. Whether you must also be currently logged on to that role, or may be logged on under another group/role is determined by the **SIGNOFF_required_group_and_role** preference. If this preference is changed from its default setting, you must be a registered member of the signoff’s required group and role, and you must be currently logged on as a member of that group and role to perform the signoff. If this situation exists at your site, and if you are logged on under another group/role, a **Change User Setting** notification appears:

```
Your current group/role does not match the required group/role --signoff group/signoff role Do you want to change your current user setting to --signoff group/signoff role?
```

**signoff group/signoff role** is the required group and role for the signoff task. Click **Yes** to automatically change your user settings to the required group/role.

11. If user authentication is implemented for this signoff task, a password box appears in the Signoff Decision dialog box and your logon password is required to perform the signoff. If this situation exists at your site, type your logon password in the Password box. This box appears only if user authentication is required for the completion of this task. This functionality is determined by the creator of the process template. It is implemented by attaching the **EPM-require-authentication** handler to the signoff task.

12. Complete the signoff of this task by performing one of the following steps:
   - Click **OK** to save the changes to the database and close the Signoff Decision dialog box.
• Click **Cancel** at any time to cancel the workflow process and exit the **Signoff Decision** dialog box.

13. Click **Close** after you finish working with all the signoff information. The **Perform Signoff** dialog box closes.

### Sign off a Review task in Workflow Viewer

Information most pertinent to a signoff task is displayed in the **Perform Signoff** dialog box. The process name, task name, and task state are listed at the top of the dialog box. View any comments and instructions by clicking the respective links. Additional task information, such as task attributes, is displayed in other dialog boxes.

Click any linked entry to display its related dialog box. For example, click a linked entry in the **Decision** column to display the **Signoff Decision** dialog box and make your signoff decision.

Tool tips are available for each column in the dialog box. Activate the tool tips by moving your cursor over the head of each column.

1. Select the signoff task to be completed, either in the task hierarchy tree or the process flow pane.

2. (Optional) If you know you have additional tasks to perform before you can perform the **perform-signoffs** task, you can create a subprocess from this task. The subprocess must complete before the **perform-signoffs** task can complete.

   For more information about creating a subprocess, see *Create a workflow subprocess*.

3. Click **Perform Task** on the toolbar.

   The **Perform Signoff** dialog box appears. The process name and task state appear at the top of the dialog box.

4. Review the contents of the **Process Description** box. If necessary, type additional information into the box.

5. If the **Responsible Party** entry contains a link, you can reassign the responsible party for this signoff task.
   a. Click the linked user name next to the **Responsible Party** entry.

   The **Assign Responsible Party** dialog box appears.

   b. The **Organization** and **Project Teams** tabs display the available groups, roles, and users to which you can reassign the role of responsible party.

   c. Select the desired group, role, or user and click **OK**.

   The task is reassigned to the selected responsible party and the dialog box closes.

6. If the **All Comments** entry is linked, comments have been written regarding this signoff task. View the comments by clicking the linked entry.
Tasks you can perform

The All Comments dialog box appears. Any comments that have yet been written by yourself and other users are displayed within the text box.

7. View attachments to the workflow process by clicking the Attachments link. The Attachments dialog box appears. Target and reference attachments are listed below the signoff task in the Task tree.

8. If the Instructions entry appears, instructions have been written for this signoff task. View the instructions by clicking the linked entry.

The Instructions box appears. All task instructions are displayed within the text box.

9. (Optional) If you do not want to perform this signoff, delegate the signoff task to a different user.
   a. Click on your user name in the User-Group/Role column.
      The Delegate Signoff dialog box appears.
   b. The Organization and Project Teams tabs display the available groups, roles, and users to which you can delegate your signoff responsibility.
   c. Select the desired group, role, or user and click OK.
      Your signoff responsibility is delegated to the selected user and the dialog box closes. The perform-signoffs task is removed from your worklist, and sent to the worklist of the selected user.

   [Note] Signoff responsibility can also be delegated by the responsible party, or a member of the System Administration group.

10. Perform any signoff assigned to you. You can perform any entry in the Decision column that is linked. Typically, you are only listed once. However, it is possible that you hold multiple entries within the signoff team, for various groups or roles.
   a. Click a linked entry in the Decision column. By default, all entries begin as No Decision.
      The Signoff Decision dialog box appears.
   b. Select either Approve, Reject, or No Decision from the Decision section of the dialog box.
      • Choosing Approve performs a signoff of the task. The link in the Decision column changes to green and reads Approve.
      • Choosing Reject performs a signoff of the task. Your decision does not count towards the quorum approval count required to complete the task. If the quorum requires all signoffs to approve, your rejection stops the workflow process. The link in the Decision column changes to red and reads Reject.
      • Choosing No Decision allows you to abstain from the signoff of the task. No Decision is the default setting for this dialog box. Your decision does not count towards the approval of the task. The link in the Decision column changes to blue and reads No Decision.
Chapter 4  Tasks you can perform

c. Type any comments regarding your decision in the Comments box. It is particularly useful to include comments when you reject a signoff.

If you want, you can also add a comment, but leave the decision set to No Decision.

d. Click OK.

The signoff decision is recorded and the dialog box closes.

**Note** You must be a member of the group/role required by the signoff task to perform a signoff. Whether you must also be currently logged on to that role, or may be logged on under another group/role is determined by the SIGNOFF_required_group_and_role preference. If this preference is changed from its default setting, you must be a registered member of the signoff’s required group and role, and you must be currently logged on as a member of that group and role to perform the signoff. If this situation exists at your site, and if you are logged on under another group/role, a Change User Setting notification appears:

```
Your current group/role does not match the required group/role --signoff group/signoff role Do you want to change your current user setting to --signoff group/signoff role?
```

signoff group/signoff role is the required group and role for the signoff task. Click Yes to automatically change your user settings to the required group/role.

11. If user authentication is implemented for this signoff task, a password box appears in the Signoff Decision dialog box and your password is required to perform the signoff. If this situation exists at your site, type your password in the Password box. This box appears only if user authentication is required for the completion of this task. This functionality is determined by the creator of the process template. It is implemented by attaching the EPM-require-authentication handler to the signoff task.

12. Complete the signoff of this task:

- Click OK to save the changes to the database and close the Signoff Decision dialog box.

- Click Cancel at any time to cancel the workflow process and exit the Signoff Decision dialog box.

13. Click Close when you have finished working with all the signoff information.

The Perform Signoff dialog box closes.

**Perform a Do task in Workflow Viewer**

To perform a Do task, follow the instructions in the Instructions box. Select Done when the task criteria is met. To complete a Do task that has reached a Started state, perform the following steps:

1. Click the Do Task to be completed, either in the task hierarchy tree or the process flow pane.
2. (Optional) If you know you have additional tasks to perform before you can perform the **Do** task, you can create a subprocess from this task. The subprocess must complete before the **Do** task can complete.

   For more information about creating a subprocess, see *Create a workflow subprocess*.

3. Click **Perform Task** on the toolbar.

   The **Perform Do Task** dialog box appears.

4. Review the task instructions listed in the **Instructions** box.

5. (Optional) Review any contents in the **Process Description** box. If necessary, type additional information into the box.

6. Complete the task instructions.

7. (Optional) In the dialog box, type any comments regarding the task in the **Comments** box.

8. Select **Complete**.

   If the task is configured with a failure path, you can also select **Unable To Complete**.

9. Type your user password in the **Password** box.

   This box appears only if user authentication is required for the completion of this task. This authorization is determined by the creator of the process template.

10. Click **OK** to save the changes to the database and close the dialog box.

11. Click **Cancel** at any time to cancel the operation without making changes to the database.

### Perform a Condition task manually in Workflow Viewer

To perform a **Condition** task, follow the instructions in the **Instructions** box. The instructions should pose a question or define a set of parameters that can be answered. **Unset** is the initial value of the task, which must be changed. The task cannot complete or the workflow process continue, while the task remains set at **Unset**. If the **Condition** task is configured with custom paths (paths that are set with result values other than true and false), the available options will reflect these custom results. The **Unable To Complete** option displays on **Perform Condition Task** dialog box, if the **Condition** task is configured with a failure path.

**Note** An automatic **Condition** task is configured to proceed during the workflow process. It acts as a visual milestone in the workflow process. There is no action for a user to perform and no dialog box associated with the automatic **Condition** task.

1. Select the **Condition** task to be completed, either in the task hierarchy tree or the process flow pane.
Chapter 4  Tasks you can perform

2. (Optional) If you know you have additional tasks to perform before you can perform the **Condition** task, you can create a subprocess from this task. The subprocess must complete before the **Condition** task can complete.

   For more information about creating a subprocess, see *Create a workflow subprocess*.

3. Click **Perform Task** on the toolbar.

   The **Perform Condition Task** dialog box displays.

4. Complete the task instructions listed in the **Instructions** box.

5. (Optional) Review any contents in the **Process Description** box. If necessary, type additional information into the box.

6. Set **Task Result** to **true** or **false**, based on the requirements listed in the **Instructions** box. If the **Condition** task is configured with custom paths (paths that are set with result values other than **true** and **false**), the available options reflect these custom results. This setting determines whether the workflow process continues along the true or false flow line branching off the **Condition** task.

   Setting the condition path to **unset** prevents the task from completing and pauses the workflow process.

7. Select **Complete**.

   If the task is configured with a failure path, you can also select **Unable To Complete**.

8. Type your user password in the **Password** text box. This text box appears only if user authentication is required for the completion of this task. This authorization is determined by the creator of the process template.

9. Click **OK** to save the changes and close the dialog box.

10. Click **Cancel** at any time to cancel the operation without making changes.

    **Note** You can set a **Condition** task result while it is still in a **Pending** state.

    - Performing a manual **Condition** task while it is pending prevents the task from appearing in the assigned user’s worklist.

    - Performing an automatic **Condition** task while it is pending preempts the query results, allowing you to override the confines of the query and manually set the task to **true** or **false**.

    If you perform a **Condition** task while it is still in a **Pending** state, you can return to the task and reset the true/false/unset setting at anytime until the task reaches a **Started** state.
Perform a Route task in Workflow Viewer

A **Route** task is the electronic equivalent of a routing sheet; the task is used to assign different responsibilities for the same task to multiple users. After you complete a **Route** task, the users are notified of their tasks by Teamcenter mail.

1. Select the **Route** task, either in the task hierarchy tree or the process flow pane.

2. (Optional) If you know you have additional tasks to perform before you can perform the **Condition** task, you can create a subprocess from this task. The subprocess must complete before the **Condition** task can complete.

   For more information about creating a subprocess, see *Create a workflow subprocess*.

3. Click **Perform Task** on the toolbar.

   The **Select Signoff Team** dialog box appears.

4. Click **Users** in the **Signoff Team** tree.

   The right pane displays the **Organization** pane.

   a. Search or select a user from the **Organization** or **Project Teams** tree. You can assign a resource pool to the task in the **Resource Pool Options**.

   For more information about using and defining resource pools, see the *My Teamcenter Guide*.

   b. Select a group, role, or user to whom the task will be assigned.

   c. Select either **Review**, **Acknowledge**, or **Notify** from the **Action** list.

   d. Click **Add**.

   Teamcenter displays the user information and action assigned to that user beneath the task node in the process tree.

   e. Repeat the previous steps to add additional users and task responsibilities.

5. If you want to use address lists to add other users, click **Address Lists** in the **Signoff Team** tree.

   The right pane displays the **Address Lists** pane.

   a. Select a list from the **Address Lists** list.

   b. Select either **Review**, **Acknowledge**, or **Notify** from the **Action** list.

   c. Click **Add**.

   Teamcenter displays the address list information and action assigned to that address list beneath the task node in the process tree.

   d. Repeat the previous steps to add address lists.

6. Optionally, modify or set the approval quorum value for the **Review** and **Acknowledge** tasks in the **Review Quorum** and **Acknowledge Quorum** boxes.
Chapter 4  Tasks you can perform

7. If you want the workflow process to wait for all reviewers before continuing, select the **Wait for Undecided Reviewers** check box.

8. Select the **Ad-hoc done** check box to indicate you have completed adding signoff team member assignments to this task.

9. Click **OK**.

Perform a Custom task in Workflow Viewer

To perform a **Custom** task, complete the form or instructions provided. Custom tasks usually involve custom forms that are unique to your company’s processes. Incorporating company forms into a custom task further automates the workflow process.

1. Select the **Custom** task in either in the task hierarchy tree or the process flow pane.

   In the process flow pane, the custom task’s subtasks appears.

2. Click **Perform Task** on the toolbar.

   The **Perform** dialog box for the selected custom task appears.

   **Note**  The **Perform** dialog box for the selected custom task varies depending on the form and/or other tasks the system administrator attaches to the selected task.

3. Complete the steps listed in the dialog box.

4. Select **Complete**.

   If the task is configured with a failure path, you can also select **Unable To Complete**.

5. Click **Close** or **OK**.

   **Note**  If the form attached to the **Custom** task is a simple form, the task may not automatically move to the **Complete** state when you click the **Finish/Close** button.

Reassign a task in Workflow Viewer

If you are the responsible party or a privileged user, you can reassign any task that has not already been started.

For example, if you are the initiator of a process, the tasks of selecting a signoff team and performing signoffs are automatically assigned to you. You may want to reassign one or both of these tasks to another user.
Note

- You can only reassign a task to another user who meets the group and role criteria defined for the selected task.

- If you want to reassign the task to yourself, use the Claim Task menu command instead.

For more information about claiming tasks, see Claim a task.

1. Select the task to be reassigned.
   You can select it in either in the task hierarchy tree or the process flow pane. In the process flow pane, the selected task’s subtasks appear.

2. Choose Actions—Assign.
   The Assign Responsible Party dialog box appears.

3. If the Responsible Party entry contains a link, you can reassign the responsible party for this signoff task. Reassign the responsible party by clicking the link next to this entry.
   The Assign Responsible Party dialog box appears. The Organization and Project Teams lists display the available groups, roles, and users to which you can reassign the task.

4. Select the desired group, role, or user. You can only reassign the selected task to a user who meets the group and role criteria required by the task.

5. (Optional) Reassign multiple tasks, as follows:
   a. Click Show Tasks.
      The system displays the pending tasks associated with the selected process in a tree structure.
   b. Select individual tasks to be reassigned, or click the Select All the Tasks button to select all displayed tasks.
      Click the Clear the Selection button to clear selections you have made in the tree.

6. Click OK or click Cancel at any time to cancel the operation without making changes to the database.

Claim a task

You can claim a task from a resource pool or another user whose worklist you have access to. This reassigns the task to you and makes you the responsible party. This is a simpler way of reassigning a task to yourself using the Assign action.

1. Open a process in Workflow Viewer.
   For more information, see Open a process.

2. Select the task in the workflow you want to claim.

3. Choose Actions—Claim Task.
4. If the task is assigned to a single user, such as a Do task or select-signoff-team task, click OK in the confirmation dialog box.

If the task is assigned to multiple users, such as a perform-signoffs task, the Claim Perform Signoff dialog box appears.

5. In the Claim Perform Signoff dialog box, select the user you want to claim the task from and click Claim.

If the Claim button is not active after selecting a user, you cannot claim the task from that user.

The task appears in your worklist, and you become the responsible party for the task.
Chapter

5 Changing a task’s state

Overriding task actions ......................................................... 5-1
Perform action ............................................................... 5-2
Complete a task with attached form ........................................... 5-3
Starting a paused task ......................................................... 5-3
Reset a paused task .......................................................... 5-3
Suspend a task ............................................................... 5-4
Resume a task ............................................................... 5-4
Skip a task in a process and start the next one ....................... 5-5
Demote a task ............................................................... 5-5
Overriding task actions

As you work through a workflow process in Workflow Viewer, a task’s actions work behind the scenes, transitioning the task from one state to another according to the actions defined in the task. You can override the task’s defined actions, if necessary.

For example, the Start action is always used to transition a task from the Pending state to the Started state.

For a more detailed explanation of actions, see Actions menu.

All tasks are transitioned by one or more of the following defined actions:

- Abort
- Assign
- Complete
- Perform
- Resume
- Skip
- Start
- Suspend
- Undo
- Failed

Note The Failed state does not appear on the Actions menu, because it can only be triggered internally.

When a task’s template is created in Workflow Designer, one or more actions become part of the task’s definition. As you work through a workflow process in Workflow Viewer, a task’s actions work behind the scenes, transitioning the task from one state to another according to the actions defined in the task.

If a task is designated to process in the background, all actions except Perform and Assign are processed in the background. The Perform and Assign action execute in the foreground.

However, there are some situations where it is necessary to override the task’s defined actions. For example, if a task is demoted, the workflow process moves backward to the preceding task. If the preceding task has an EPM-demote handler, it is automatically initiated. But if the preceding task does not have an EPM-demote handler, the task must be initiated manually. Thus, the responsible party or a privileged user must manually override the preceding task’s defined action and change the task state to Start.
Perform action

Several of these actions are used to place the task in a special state such as **Suspended** or **Skipped**. Not all tasks use all actions. The following figure shows the EPM task actions and corresponding states.

**Task actions and states**

In addition to task transition, from one state to another, actions are also used to implement rules. This is done by attaching one or more handlers to an action. There is one action, **Perform**, that does not transition a task to another state. The **Perform** action executes any handlers attached to it and displays an interactive panel.

All tasks require resources to perform actions. Resources are one of the following object types:

- **Groups**
- **Roles**
Users

Complete a task with attached form

If a simple form is assigned as the Perform action for a task and it is not specialized to initiate a Complete action, the task does not complete automatically. When the form completes, the responsible party or a privileged user with bypass ability must manually signify that the associated task is complete by using the Complete action.

Note To perform this action, you must be the responsible party or a privileged user.

1. Click the desired task with the completed form. All of the actions for this task must have been completed.

2. Choose Actions→Complete.
   The Complete Action Comments dialog box appears.

3. Type your comments in the dialog box.
   The comments are listed in the audit file.

4. Click OK.
   The selected task moves to the Complete state and the button of a flag appears in the upper left corner. The succeeding task switches to Start.

Note If a task is designated to process in the background, the move to the Complete state might be delayed.

Starting a paused task

In rare cases, tasks become stalled and must be initiated manually.

To reset the tasks to Start, the responsible party or a privileged user with bypass ability can instruct the tasks to move to a new state by performing a Start action on the task.

Note • To perform this action, you must be the responsible party or a privileged user.

• If a task is designated to process in the background, the move to the Complete state might be delayed.

Reset a paused task

1. Click the task that has stalled.

2. Choose Actions→Start.
   The Start Action Comments dialog box appears.
Chapter 5  *Changing a task’s state*

3. Enter your comments into the dialog box. The comments are listed in the audit file.

4. Click **OK**.
   The selected task moves to the **Start** state and the button of a green light appears in the upper left corner.

   **Note** If a task is designated to process in the background, the move to the **Start** state might be delayed.

**Suspend a task**

1. Select the task you want to suspend.
   
   **Note** You must be the responsible party or a privileged user to suspend a task.

2. Choose **Actions→Suspend**.
   The **Suspend Action Comments** dialog box appears.

3. Type your comments into the dialog box. The comments are listed in the audit file.

4. Click **OK**.
   The selected task moves to the **Suspend** state, and a red light button appears in the upper left corner.

   **Note** If a task is designated to process in the background, the move to the **Suspend** state might be delayed.

**Resume a task**

1. Select the desired suspended task.
   
   **Note** The only valid action for a suspended task is **Resume**. You must be the responsible party or a privileged user to resume a task.

2. Choose **Actions→Resume**.
   The **Resume Action Comments** dialog box appears.

3. Type your comments into the dialog box. The comments are listed in the audit file.

4. Click **OK**.
   The selected task moves to the state it was in prior to the **Suspend** action.

   **Note** If a task is designated to process in the background, the move to the prior state might be delayed.
Skip a task in a process and start the next one

The **Promote** menu command moves the task to a **Skipped** state and starts the successor tasks in the workflow process.

Workflow Viewer treats a **Skipped** task much like a **Completed** task.

**Note** To perform this action, you must be a privileged user.

1. Select the task you want to promote.
2. Choose **Actions→Promote**.
   
The **Promote Action Comments** dialog box appears.
3. Enter your comments into the dialog box.
4. If the task is a **Review** or **Route** task and it has a reject path, click either the **Approve** or **Reject** decision to determine the path you want the workflow process to follow.
   
   This helps you to expedite the review process where you want to move the workflow process along despite rejections.
5. Click **OK**.

The selected task moves to the **Skipped** state and the next task in the process is started. The comments you entered are listed in the audit file.

**Note** If a task is designated to process in the background, the move to the **Skipped** state may be delayed.

Demote a task

The **Demote** menu command is the method of moving an active workflow process back to some predefined release level. Performing a demote action upon a task changes the task’s state from **Started** to **Pending**. The specific demote behavior of any given task is configured within the original process template. For subtasks to also demote when a parent task is demoted, the **EPM-demote** handler must be applied to the task’s **Undo** action when the process template is configured. Demoting a **Review** task removes any signoff decisions previously made by members of the task’s signoff team, but any comments are kept.

**Note** To perform this action, you must be a privileged user.

1. Select the task you want to demote.
2. Choose **Actions→Demote**.
   
The **Demote Action Comments** dialog box appears.
3. Type your comments into the dialog box.
   
The comments are listed in the audit file.
4. Click **OK**.
Chapter 5  Changing a task’s state

The selected task moves to the designated state.

**Note**  If a task is designated to process in the background, the move to the designated state might be delayed.
Chapter

6  Workflow templates in Teamcenter Rapid Start

Workflow templates in Teamcenter Rapid Start .......................... 6-1
Engineering Order ................................................................. 6-1
Production Release .............................................................. 6-2
Obsolescence Process .......................................................... 6-3
Development Release ............................................................ 6-3
Status Change ................................................................. 6-4
Change Status to Rejected ..................................................... 6-4
Change Status to Review ......................................................... 6-5
Change Status to Released ..................................................... 6-6
Chapter

6  Workflow templates in Teamcenter Rapid Start

Workflow templates in Teamcenter Rapid Start

The workflow templates available in Teamcenter Rapid Start are:

- Engineering Order
- Production Release
- Obsolescence Process
- Development Release
- Status Change
- Change Status to Rejected
- Change Status to Review
- Change Status to Released

Engineering Order

The Engineering Order workflow approves a change to an item or BOM and releases the parts with a status of 60 (Released).
**Task** | **Task type** | **Task description**
--- | --- | ---
Create_Request | Review task | Select a signoff team. Perform signoff tasks (to be completed by the members of the selected signoff team). Complete the change request form and add the reference data.

Rejected? | Condition task | Select **false** if you approve the change request and continue the workflow. Alternatively, if you do not want to approve the change request, select **true**. This stops the workflow and moves it to the **Request Denied** task.

Request Denied | Acknowledge task | If you select **false** in the **Rejected** task, it aborts the workflow processes.

Manager Approved | Review task | If you select **true** in the **Rejected** task, it moves to **Manager Approval**.

Approve the review task to complete the **Manager Approval**.

Create Engineering Order | Review task | Approve the review task to complete the Engineering Order. Add new, revised, or obsolete parts.

In_approval | Review task | Select the signoff team to release the engineering order. Perform signoff tasks (to be completed by the members of the selected signoff team).

Finish | Finish task | Complete the workflow.

### Production Release

The Production Release workflow releases an item or BOM with a status of **60** (Released).

**Task** | **Task type** | **Task description.**
--- | --- | ---
Start | Start task | Start the workflow.

in_self_check | Review task | Approve the review task to continue the workflow process.

in_approval | Review task | Select the signoff team for **Production Release**. Perform signoff tasks (to be completed by the members of the selected signoff team).
**Workflow templates in Teamcenter Rapid Start**

<table>
<thead>
<tr>
<th>Task</th>
<th>Task type</th>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Add Status task</td>
<td>When the in_approval task is complete, the status of target objects is set to 60 (Released).</td>
</tr>
<tr>
<td>Finish</td>
<td>Finish task</td>
<td>Complete the workflow.</td>
</tr>
</tbody>
</table>

**Obsolescence Process**

The Obsolescence Process workflow marks an item or BOM as obsolete.

![Obsolescence Process Diagram]

<table>
<thead>
<tr>
<th>Task</th>
<th>Task type</th>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Start task</td>
<td>Start the workflow.</td>
</tr>
<tr>
<td>in_Self_Check</td>
<td>Review task</td>
<td>Approve the review task to continue the workflow process.</td>
</tr>
<tr>
<td>in_Approval</td>
<td>Review task</td>
<td>Select the signoff team for Obsolescence Release. Perform signoff tasks (to be completed by the members of the selected signoff team).</td>
</tr>
<tr>
<td>Status</td>
<td>Add Status task</td>
<td>When the in_Approval task is complete, the status of target objects is set to 90 (Obsolete).</td>
</tr>
<tr>
<td>Finish</td>
<td>Finish task</td>
<td>Complete the workflow.</td>
</tr>
</tbody>
</table>

**Development Release**

![Development Release Diagram]

<table>
<thead>
<tr>
<th>Task</th>
<th>Task type</th>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Start task</td>
<td>Start the workflow.</td>
</tr>
<tr>
<td>in_Self_Check</td>
<td>Review task</td>
<td>Approve the review task to continue the workflow process.</td>
</tr>
<tr>
<td>in_Approval</td>
<td>Review task</td>
<td>Select the signoff team for Obsolescence Release. Perform signoff tasks (to be completed by the members of the selected signoff team).</td>
</tr>
</tbody>
</table>
Chapter 6  Workflow templates in Teamcenter Rapid Start

<table>
<thead>
<tr>
<th>Task</th>
<th>Task type</th>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Add Status task</td>
<td>When the in_approval task is complete, the status of target objects is set to 30.</td>
</tr>
<tr>
<td>Finish</td>
<td>Finish task</td>
<td>Complete the workflow.</td>
</tr>
</tbody>
</table>

Status Change

![Diagram of Status Change workflow]

<table>
<thead>
<tr>
<th>Task</th>
<th>Task type</th>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Start task</td>
<td>Start the workflow.</td>
</tr>
<tr>
<td>in_Approval</td>
<td>Review task</td>
<td>Select the signoff team for <strong>Status Change</strong>. Perform signoff tasks (to be completed by the members of the selected signoff team).</td>
</tr>
<tr>
<td>Status</td>
<td>Add Status task</td>
<td>When the in_approval task is complete, the status of target objects is set to <strong>60 (Released)</strong>.</td>
</tr>
<tr>
<td>Finish</td>
<td>Finish task</td>
<td>Complete the workflow.</td>
</tr>
</tbody>
</table>

Change Status to Rejected

The **Change Status to Rejected** workflow marks an item or BOM as **10 (Rejected)**.

![Diagram of Change Status to Rejected workflow]

<table>
<thead>
<tr>
<th>Task</th>
<th>Task type</th>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Start task</td>
<td>Start the workflow.</td>
</tr>
</tbody>
</table>
Change Status to Review

The Change Status to Review workflow marks an item or BOM as 20 (Review).

<table>
<thead>
<tr>
<th>Task</th>
<th>Task type</th>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Reviewed</td>
<td>Condition task</td>
<td>Automatically check to see if the status of the target object is 20 (Review).</td>
</tr>
<tr>
<td>Change Status from</td>
<td>Task</td>
<td>If the status of the target object is 20 (Review), set the status to 10 (Rejected).</td>
</tr>
<tr>
<td>Review to Rejected</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Do Nothing</td>
<td>Do task</td>
<td>If the status of the target object is not 20 (Review), do nothing.</td>
</tr>
<tr>
<td>Finish</td>
<td>Finish task</td>
<td>Complete the workflow.</td>
</tr>
</tbody>
</table>

Start

Start task

Task description

Start the workflow.
<table>
<thead>
<tr>
<th>Task</th>
<th>Task type</th>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check UnRevised</td>
<td>Condition task</td>
<td>Automatically check the status of the target object.</td>
</tr>
<tr>
<td>Mark Reviewed</td>
<td>Add Status task</td>
<td>If the revision has no status attached, the status of the target object is set to 20 (Review).</td>
</tr>
<tr>
<td>Check Rejected</td>
<td>Condition task</td>
<td>Automatically check to see if the status of the target object is 10 (Rejected).</td>
</tr>
<tr>
<td>Rejected to Review</td>
<td>Task</td>
<td>If the status of the target object is 10 (Rejected), change the status to 10 (Rejected).</td>
</tr>
<tr>
<td>Do Nothing</td>
<td>Do task</td>
<td>If the status of the target object is not 10 (Rejected), do nothing.</td>
</tr>
<tr>
<td>Finish</td>
<td>Finish task</td>
<td>Complete the workflow.</td>
</tr>
</tbody>
</table>

**Change Status to Released**

The Change Status to Released workflow releases an item or BOM with a status of 60 (Released).

![Workflow Diagram]

<table>
<thead>
<tr>
<th>Task</th>
<th>Task type</th>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Start task</td>
<td>Start the workflow.</td>
</tr>
<tr>
<td>Check Reviewed</td>
<td>Condition task</td>
<td>Automatically check to see if the status of the target object is 20 (Review).</td>
</tr>
<tr>
<td>Change Status to Released</td>
<td>Task</td>
<td>If the status of the target object is 20 (Review), change the status to 60 (Released).</td>
</tr>
<tr>
<td>Do Nothing</td>
<td>Do task</td>
<td>If the status of the target object is not 20 (Review), do nothing.</td>
</tr>
<tr>
<td>Finish</td>
<td>Finish task</td>
<td>Complete the workflow.</td>
</tr>
</tbody>
</table>
Appendix

A Glossary
Appendix

A  Glossary

access control entry (ACE)
In Access Manager, each pairing in the access control list of an accessor with the granted privileges.

access control list (ACL)
Access Manager component that contains a list of accessors and, for each accessor, the privileges granted, denied, and not set.

Access Manager (AM)
Teamcenter application that enables the system administrator to grant users access to Teamcenter objects.

ACE
See access control entry (ACE).

ACL
See access control list (ACL).

action handler
Handler used to extend and customize workflow task actions. Action handlers perform such actions as displaying information, retrieving the results of previous tasks (inherit), notifying users, setting object protections, and launching applications. See also task handler.

add status task
Task template that creates and adds a release status to the target objects of a workflow process. There is no dialog box associated with this template.

ad hoc process modification
Functionality that allows users to add tasks to, or delete tasks from, an active workflow process.

AM
See Access Manager (AM).

approver
User who has a signoff in a workflow process regardless of role and group membership. In Access Manager, the approver accessor is used to allocate privileges that apply to all signoffs (for example, read access). See also RIG approver, role approver, and group approver.
Appendix A  Glossary

D

Do task
Task template that includes the EPM-hold handler, which stops the task from automatically completing when the task is started. This template has a customized dialog box that allows administrators to set a check box to indicate when the task is complete.

G

group approver
User who is a signoff in a workflow process with a specific group of users. In Access Manager, the group approver accessor is used in Workflow ACLs and matches the signoff definition (that is, group) for the release level associated with the Workflow ACL. The group approver accessor ensures that only signoffs are given privileges, not a user who matches the group. See also approver, RIG approver, and role approver.

P

privileged user (workflow)
Responsible party, process owner, or member of the system administration group. Privileged users have greater control over workflow tasks. For example, they can promote, demote, and skip workflow tasks.

process owner
User who initiates the workflow process; also known as the process initiator. When the process is initiated, the process owner becomes the responsible party for the process. Whenever any task in the process is not explicitly assigned to another user, person, or resource pool, the responsible party for the task defaults to the process owner.

process template
Blueprint of a workflow process defined by placing workflow and/or change management tasks (for example, do, perform signoff, route, and checklist) in the required order of performance. Additional process requirements, such as quorums and duration times are defined in the template using workflow handlers.

Q

quorum
Number of users who must vote to approve a task for that task to be approved.

R

release status
Status associated with a workspace object when it is released through a workflow process.

review task
Task template that includes the select-signoff-team and perform-signoffs subtasks. Each subtask contains a unique dialog box for executing the process.
**RIG approver**
User who is a signoff in a workflow process with a specified role and group. In Access Manager, the RIG approver accessor is used in Workflow ACLs and matches the signoff definition (that is, role in group) for the release level associated with the Workflow ACL. This accessor ensures that only signoffs are given privileges, not a user who matches the role in group. See also approver, group approver, and role approver.

**role approver**
User who is a signoff in a workflow process with a specific role. In Access Manager, the role approver accessor is used in Workflow ACLs and matches the sign-off definition (that is, role in group) for the release level associated with the Workflow ACL. This accessor ensures that only signoffs are given privileges, not a user who matches the role. See also approver, group approver, and RIG approver.

**rule handler**
Handler used to integrate workflow business rules into Enterprise Process Modeling processes at the task level. Rule handlers attach conditions to an action. See also task handler.

**task handler**
Small Integration Toolkit program or function. Handlers are the lowest level building blocks in Enterprise Process Modeling. They are used to extend and customize tasks. There are two kinds of handlers: action handlers and rule handlers. See also action handler and rule handler.

**workflow**
Automation of the concept that all work flows through one or more business processes to accomplish an objective. Using workflow, documents, information, and tasks are passed between participants during the completion of a particular process.

**Workflow Designer**
Teamcenter application that enables administrators to graphically design workflow process templates, incorporating company business practices and procedures into the templates. Teamcenter users initiate workflow processes using these templates.

**Workflow Viewer**
Teamcenter application that enables users to view the progress of a workflow process. Users are not required to be participating members of the process being viewed. Depending on preference settings, Workflow Viewer also allows ad hoc process modification. See also ad hoc process modification.
Index

E
Edit command .......................... 1-8
Edit menu ............................ 1-7
Editing active workflow processes .. 3-1–3-2
Enabling Workflow Viewer ............. 1-1
Engineering order workflow template .. 6-1
EPM tasks ............................. 1-5
Export audit logs from Details view ... 2-20
Export To Excel dialog box ......... 2-20, 2-26

F
File menu .............................. 1-7

G
Go menu ............................... 1-10

H
Handlers Hierarchy tree ............... 2-17
Handlers pane ......................... 1-14, 2-17

L
Launching parent processes in Workflow Viewer ..................... 2-1, 2-3
Launching subprocesses in Workflow Viewer ........................ 2-1, 2-3
Launching workflow processes from a reference ..................... 2-2, 2-4
Launching workflow processes from objects ......................... 2-4
Launching workflow processes in Workflow Viewer ................ 2-1

M
Manual condition task, completing .... 4-13
Menus
   Actions ............................ 1-9
   Edit ................................ 1-7
   File ................................ 1-7
   Go .................................. 1-10
   View ................................ 1-8
Modifying active workflow processes .......... 3-1–3-2

N
Named ACL box ........................ 2-14
No date set value ....................... 2-14

O
Obsolescence process workflow template .......... 6-3
Opening parent processes .............. 2-1, 2-3
Opening subprocesses .................. 2-1, 2-3
Opening workflow processes ........... 2-1–2-2, 2-4
Overdue tasks .......................... 2-14

P
Panes
   Handlers ............................ 1-14
   Process flow ......................... 1-6
   Signoff Profiles .................... 1-14
   Template manager .................. 1-6
Parent workflow processes ......... 2-1, 2-3
Paused task, starting ................. 5-3
Perform command ..................... 1-9
Perform dialog box .................... 1-9
Perspectives
   In general .......................... 1-14
Preferences
   SIGNOFF_required_group_and_role ..................... 4-9, 4-12
   WORKFLOW_adhoc_process .................. 3-1
Prerequisites for Workflow Viewer .... 1-1
Privileged user ....................... 2-6
Process ................................ 2-5
Process flow pane .................... 1-6
Process owner ......................... 2-7
Process template ...................... 2-5
Production release workflow template .... 6-2
Promote command ..................... 1-10
Promoting tasks ....................... 5-5

Q
Quorum ............................... 2-17

R
Reassigning a task .................... 4-16
Recipients ............................ 2-15
Recipients box ....................... 2-14
References folder ..................... 2-16
Responsible party ..................... 2-6
Responsible Party box ................. 2-13
Resume command ..................... 1-10
Review task .......................... 4-10
Rich client perspectives and views .... 1-14
Rich client views ...................... 1-15
Route tasks ............................ 4-15
Rule handlers ......................... 2-17
Running workflow processes ........... 3-1

S
Searching ............................. 2-4
Send To command ..................... 2-1, 2-4
Index

| Signing off | Acknowledge task | 4-7 |
| Review task | 4-10 |
| Tasks | 4-7 |
| Signoff Profiles pane | 1-14 |
| Signoff team profiles, viewing | 2-6 |
| Signoff team, selecting | 4-2 |
| SIGNOFF_required_group_and_role preference | 4-12 |
| SIGNOFF_required_group_and_role preference | 4-9 |
| Signoffs pane | 2-6 |
| Signoffs Quorum box | 2-14 |
| Skipping tasks | 5-5 |
| Stand-in command | 1-10 |
| Start command | 1-9 |
| Starting Workflow Viewer | 1-1 |
| State box | 2-13 |
| Status Change workflow template | 6-4 |
| Subprocess creation | 3-4 |
| Suspend command | 1-9 |
| Task, modifying | 3-1 |
| Top level commands | 1-10 |
| Trees | 2-17 |
| Handlers Hierarchy | 2-17 |
| Task hierarchy | 1-6 |
| U | Up a Level command | 1-10 |
| V | View audit logs | 2-17, 2-21 |
| Audit queries | 2-20 |
| Summary view | 2-18 |
| View menu | 1-8 |
| View tables | 2-24 |
| Configuring | 2-24 |
| Viewing parent processes in Workflow Viewer | 2-1, 2-3 |
| Viewing processes in Workflow Viewer | 2-4 |
| Viewing subprocesses in Workflow Viewer | 2-1, 2-3 |
| Views | 1-15 |
| Rich client | 1-15 |
| W | Where Referenced | 2-4 |
| Where Referenced command | 2-2 |
| Workflow | Assigning a task | 4-16 |
| Reassigning a task | 4-16 |
| Workflow processes | Modifying | 3-2 |
| Viewing | 2-1–2-2 | 2-4 |
| Viewing parent process | 2-1, 2-3 |
| Viewing subprocess | 2-1, 2-3 |
| Workflow subprocesses | 2-1, 2-3 | 3-4 |
| Workflow templates in Teamcenter | Change Status to Rejected | 6-4 |
| Change Status to Released | 6-6 |
| Change Status to Review | 6-5 |
| Development Release | 6-3 |
| Engineering order | 6-1 |
| Obsolescence process | 6-3 |
| Production Release | 6-2 |
| Status Change | 6-4 |
| Workflow templates in Teamcenter Rapid Start | About | 6-1 |
| Workflow, Completing route tasks | 4-15 |
| WORKFLOW_adhoc_process preference | 3-1 |

- Tables
  - Configure view tables data display | 2-24 |
  - Targets folder | 2-16 |
  - Task attachments
    - Viewing | 2-16 |
    - Task attributes, viewing | 2-13 |
    - Task handlers, Viewing | 2-16 |
    - Task hierarchy tree | 1-6 |
    - Task Properties commands | 1-8 |
    - Task Properties dialog box | 1-8 |
  - Task states
    - Viewing | 1-5 |
  - Task template, modifying | 3-1 |
  - TASK_MONITOR_SLEEP_TIME value | 2-15 |
  - Tasks
    - Acknowledge | 4-7 |
    - Completing with attached form | 5-3 |
    - Demoting | 5-5 |
    - Overdue | 2-14 |
    - Overriding actions | 5-1 |
    - Promoting | 5-5 |
    - Review | 4-10 |
    - Signing off | 4-7 |
    - Skipping | 5-5 |
    - Starting paused | 5-3 |
  - Teamcenter perspectives and views | 1-14 |
  - Template manager pane | 1-6 |
  - Templates
    - Active process, modifying | 3-1 |

- U
  - Up a Level command | 1-10 |

- V
  - View audit logs | 2-17, 2-21 |
    - Audit queries | 2-20 |
    - Summary view | 2-18 |
  - View menu | 1-8 |
  - View tables
    - Configuring | 2-24 |
    - Viewing parent processes in Workflow Viewer | 2-1, 2-3 |
    - Viewing processes in Workflow Viewer | 2-4 |
    - Viewing subprocesses in Workflow Viewer | 2-1, 2-3 |
  - Views
    - Rich client | 1-15 |

- W
  - Where Referenced | 2-4 |
  - Where Referenced command | 2-2 |
  - Workflow
    - Assigning a task | 4-16 |
    - Reassigning a task | 4-16 |
  - Workflow processes
    - Modifying | 3-2 |
    - Viewing | 2-1–2-2 | 2-4 |
    - Viewing parent process | 2-1, 2-3 |
    - Viewing subprocess | 2-1, 2-3 |
  - Workflow subprocesses | 2-1, 2-3 | 3-4 |
  - Workflow templates in Teamcenter
    - Change Status to Rejected | 6-4 |
    - Change Status to Released | 6-6 |
    - Change Status to Review | 6-5 |
    - Development Release | 6-3 |
    - Engineering order | 6-1 |
    - Obsolescence process | 6-3 |
    - Production Release | 6-2 |
    - Status Change | 6-4 |
  - Workflow templates in Teamcenter Rapid Start
    - About | 6-1 |
  - Workflow, Completing route tasks | 4-15 |
  - WORKFLOW_adhoc_process preference | 3-1 |
Index

Y
Year box .......................... 2-14